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1. Preface
User Manual

for
Kongsberg XP

running i-cut Production Console 2.1

Note:  We remind you that only the Esko staff, or persons having received appropriate training,
are allowed to handle, manipulate or do repairs on the system.

©Copyright 2017, Esko-Graphics Kongsberg AS, Norway

All Rights Reserved.

This copyright does not indicate that this work has been published.

This material, information and instructions for use contained herein are the property of Esko-Graphics
Kongsberg AS. There are no warranties granted or extended by this document. Furthermore, Esko-Graphics

Kongsberg AS does not warrant, guarantee or make any representations regarding the use, or the results
of the use of the system or the information contained herein. Esko-Graphics Kongsberg AS shall not be

liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use
the system or the information contained herein. The information contained herein is subject to change
without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this system may be reproduced, stored in a data base or retrieval system, or
published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm

or any other means without prior written permission from Esko-Graphics Kongsberg AS.

This document supersedes all previous dated versions.

Correspondence regarding this publication should be forwarded to:

Global support

Esko-Graphics Kongsberg AS

Document no: D3621

Part no: 32597502

Esko-Graphics Kongsberg AS
www.esko.com

P.O.Box 1016, N-3601 Kongsberg, Norway
Tel: +47 32 28 99 00  Fax: +47 32 28 85 15 / 32 28 67 63
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2. Change Record

Date

dd-mm-yy

By Description

03-02-2017 jhbe TakeUp Unit, information added
18-04-2017 jhbe Measuring station operation, information

added.
20-04-2017 jhbe Braille tool description added
20-04-2017 jhbe Bevel 45 tool adapter description added
03-07-2017 jhbe Tool Insert Position, limitation information

added.
07-08-2017 jhbe The importance of Braille tool height

adjustment has been emphasized.
30-08-2017 jhbe Braille tool info added
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3. Welcome

Welcome to the User Manual for Kongsberg XP running iPC.

This manual will provide a complete and detailed description of all Cutting Table functions.

There is a separate user manual for i-cut Production Console (iPC). Thus, actual GUI functions
will be referenced in this manual, but the complete and comprehensive description is available
in the User Manual for i-cut Production Console.

This manual is aimed for operators of Kongsberg Cutting Tables and people preparing files
for such equipment.

Another source for information is the manual: Get the best out of iPC 2.0.

Note: Some of the functions and equipments described in this manual are optional.

9
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4. Using this manual

4.1 Main Sections
The manual is divided into the following Main Sections:

Safety Regulations

• All safety related issues are discussed.

System Description

• This chapter provides basic knowledge about the machine.

Basic Operations

• This chapter provides basic knowledge about how to operate the machine.

Prepare for a Job

• A typical workflow is described, with detailed information about each step.

How to Procedures, Advanced
Optional functions for the advanced user:

• Cutting Thick Materials - advices.

• Hard Board Production - advices.

• Multi Pass Creasing or Milling - how to.

• Jobs including Reverse Operations - how to.

• Work with different Reference Point Settings - how to.

• MultiZone Production - how to.

Work with Registration Marks

• A step by step workflow.

System Setup

• Settings specifying the general behaviour of the system.

Tool Configuration and Adjustment

10
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• General information about the tooling and adjustment of tools.

Tooling System

• Tool descriptions.

Maintenance

• This chapter describes maintenance to be carried out by the customer.

Fuse Replacement

• Fuse location and specification.

Appendices

• Roll Feeder - basic information.

• Vacuum Cleaner - basic information.

4.2 Name Styles and Symbols

Name or style Description
Pop-up dialog This is the dialog that appears when you click the Right

mouse button.
Start button The italic style indicates this is a button on the Operator

Panel.
OK The bold style indicates this is a button or function in

the GUI.
Maintenance Link to topic.

 Menu Bar->Edit-> Options
Menu selection: From Menu Bar, select Edit and then
Options.
This symbol indicates that the function depends upon
actual hardware.

If hardware is not available, this functions is hidden.

This symbol indicates that the function is license
dependant.

4.3 Pictures and Illustrations

Orientation

In this document, pictures and illustrations related to the Cutting Table are viewed as shown
here:

11
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4.4 Local Languages

This manual is available in a wide range of local languages.

Screen pictures and illustrations remains in English language.

12
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5. Safety Regulations

5.1 Introduction
The XP table is designed to conform to Safety Regulation standards.

Nevertheless, operating the table can involve hazards if :

• The operator does not follow the Operating Instructions
• The table is used for non-intended purposes.

In addition to the Safety Regulation described below, you will find safety warnings in the
respective topics.

5.2 Responsibilities

5.2.1 The Manufacturer

The Manufacturer is responsible for delivering the system according to Safety Regulation
standards.

5.2.2 The Customer

The Customer is responsible for:

• Ensuring that the system is used for it's Intended Use only
• Allowing that only authorized and trained personnel operate the system
• Preventive maintenance as described in the Maintenance chapter.
• That the Local Regulations regarding installation and operation are fulfilled.

5.2.3 The Operators

The Operators are responsible for:

• Operating the system only when it is in a flawless state.
• Operating the system according to Operating Instructions.

13
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• Ensuring that no Unauthorized Personnel come close to the system.

5.3 Requirements to be met by Operators
Personnel operating the system must:

• Be adequately trained.
• Have read and understood the instructions described in Safety Regulation as well as any

other safety warnings.

5.4 Definition of Use
Intended use is described in the User Manual for i-cut Production Console.

In this manual, Intended use is described in the following chapters:

• Basic Operations

• Prepare for a Job

• How to Procedures, Advanced

Any other use is considered Non-intended use.  

Examples of Non-intended use:

• Operation by operators not meeting the requirements as described above.
• Unauthorized modifications (bridging safety devices, removing covers etc.)
• Utilizing accessories other than those specified by Esko.

Non-intended use may cause:

• Health hazards and injuries.
• Damage to the system.
• Incorrect functionality.
• Damage to work materials.

Note:  Esko is not liable for any damage resulting from such Non-intended use. 
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5.5 Warning Sign Explanation

Knife Blades are extremely sharp.

This symbol is used in this documentation to indicate operations with
Knife Blades and Milling bits.

Hand Squeeze

Potential areas with a risk of being squeezed are marked with the Hand
Squeeze sign.

These areas are:

• Between X-axis end stopper and traverse wagon.

Moving Parts

Potential areas with a risk of being hit by Moving Parts are marked with
the Moving Parts sign.

These areas are:

• Both traverse ends.
• Y carriage.
• Tool head(s).

Do not Touch

Potential areas with a risk of being squeezed are marked with the Do
Not Touch sign.

These areas are:

• Between Y carriage and rack
• Between the table top and the moving traverse.
• Underneath the tool head.

Hearing Protection
The Hearing Protection symbol indicates areas where the use of
hearing protection is compulsory.

Eye Protection

The Eye Protection symbol indicates areas where the use of eye
protection is compulsory.

15
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The Main Power Unit (MPU) contains Mains Voltage and
may be opened by Authorized Personnel only.

The MPU is marked with the High Voltage warning sign.

Laser Radiation.

The tool head is equipped with a class II Laser Pointer.

Avoid laser light into your eyes.

Do not push or pull traverse beam

Use Manual Jog functions to move the
traverse.

16
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5.6 Attention Areas

5.6.1 Moving Parts, Laser Radiation and High Voltage

5.6.2 Loose Clothing

While working with this machine, do not:

• Use ties
• Use loose necklaces
• Use scarfs

5.6.3 Noise Level

• Hearing Protection should be used by any personnel exposed to the noise
from the machine.

5.6.4 Ejection of Parts

17
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Potential risk when running HPMU
Personnel hit by breaking milling bit or small pieces of processed material.

• Eye Protection should be used by any
personnel working with HPMU.

5.6.5 i-Camera strobing light

If your system includes i-Camera, please read this warning carefully:

WARNING

i-Camera is equipped with LED strobing light.

The LED default frequency (10 Hz) is in a range that
can cause photosensitive epileptic reactions amongst
susceptible people.

If a person is known to be susceptible, the frame rate,
frequency of strobing, can be reduced to as low as 1 Hz
from the camera configuration menu.

At that rate, seizures are not known to happen.

18
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5.7 Safety Devices

5.7.1 Overview

1 The Main Power Switch
2 Emergency Stop Button
3 Yellow / Black tape on the floor to indicate Attention Area
4 Warning Lamp
5 Dynaguard

5.7.2 Emergency Stop Button

Emergency Stop buttons.

19
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Switch positions
OUT - Emergency Stop is switched OFF.  
IN - Emergency Stop is switched ON; Servo Power to the machine is switched off.

Note:

Activating the Emergency Stop Button does not provide a guarantee against injury!

Due to the high kinetic energy of moving parts, do not underestimate stopping distances of
traverse, Y carriage and tool head.

Continue after Emergency Stop
To continue operation, proceed as follows:

1. Ensure the table is free from obstructions and ready for operation.
2. Pull out the Emergency Stop button.
3. Reset the Safety System by pressing the Pause / Servo On push button.
4. Observe that Servo Power is switched on.
5. Press Start to continue.

5.7.3 Yellow / Black tape

The yellow / black tape indicates the Attention area.

This area is restricted to operators and other trained personnel.

5.7.4 Warning Lamp on top of Y carriage

Light is Description
Off Servo Power is off
On Servo Power is on, Safety System is enabled, table is ready for operation
Flashing Safety System is activated.

Reset Safety System to continue operation

20
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5.7.5 DynaGuard Safety System

The DynaGuard Safety System consists of:

• Two light beams in front of the traverse and two behind.
• One light beam on traverse front to prevent squeeze risk.
• A stop mechanism mounted on each end of the traverse.

Machine movement will stop and Servo Power will be switched off if:

• One of the light beams is broken.
• The stop mechanism is activated.

Continue Operation
To continue operation after the DynaGuard Safety System system has been activated, do:

1. Ensure the table is free from obstructions and ready for operation.
2. Ensure the Traverse Safety Stop switches are centered, see illustration below
3. Reset the Safety System by pressing the Pause / Servo On push button.
4. Observe that Servo Power is switched on.
5. Press Start to continue.

5.8 Protective Equipment

For the operator(s), Esko recommends the following Protective Equipment:

Close-fitting clothes to avoid being caught by the beam or the tool head
which can cause injuries.

21



5 Kongsberg XP

Gloves to protect against cuts from materials with sharp edges.

Eye protection should be used by any personnel working with milling.

Always use Hearing Protection when working with the machine for a
longer period of time.

The acoustic noise level will vary with the type of operation and tooling,
but a typical average level is 78.5 – 83.5 dBA and a maximum level of
98.5 dBA.

5.9 Procedures in case of Malfunctions
Trouble-shooting and repair shall be executed by Authorized Personnel only.

Contact the Esko Service Organization.

5.10 Residual Risk
Despite all safety protection means incorporated in this machine, there are some Residual
Safety Risks to be aware of:

Beneath traverse end

The low part of the traverse end is un-
protected.

Actions:

• Children are not supposed to be in the
machine area.

• Do not work or stay beneath the traverse
while the machine is working.

22
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Y-carriage

The top of the Y-carriage is un-protected in all
four directions.

Actions:

• Do not bend down over the table or
traverse while the machine is working.

Rear side of traverse

The DynaGuard Safety System photo cell
beam will stop the movement when hit.

When the Feeder Paws are mounted, the
distance between beam and the mechanics is
reduced.

Actions:

• Stay out of this area while the machine is
working.

Inside cable chain

There is a risk for squeezing between the cable
chain and the table frame.

Actions:

• Stay out of this area while the machine is
working.

23
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6. System Description

6.1 Naming Conventions
Machine

1 Cutting Table 5 Main Power on/off switch
2 Tools 6 Operator Panel
3 Y carriage 7 Emergency Stop button
4 Traverse 8 Main Power Unit (MPU)

Axes

X - X-axis P1 - P1 Tool Position.
Y - Y-axis P2 - P2 Tool Position.
X1 - X1 end of traverse
X2 - X2 end of traverse

24
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6.2 Main Power Switch

The Main Power Switch is located on the Operator Station:

Switch positions
O - Main Power to the machine is switched OFF.
I - Main Power to the machine is switched ON.

6.3 Operators Panel

Power On

Mains Power on/off indication.

Servo Power On

Servo Power on/off control.

Start

Press this button to Start Operation.

25
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Pause / Safety System Reset

Press this button to Pause Operation and Reset Safety System.

Vacuum On/Off

Press this button to switch Vacuum On/Off.

Provides material hold down.

Set Panel Reference Point

Press this button to set Panel Reference Point.

If Fixed Reference Point is disabled, the current position of Laser
Pointer is set as the new Reference Point.

Move to Table Zero

Press this button, then the Start button, to move the tool head to
Selected Reference Point.

The Table Zero Mode is automatically selected at Power on.

The system remains in the Table Zero Mode until Table Zero
movement is completed.
 

Jog buttons

Press the Jog buttons to move the tool head in the desired direction.

The system must be in Pause mode, i.e. the Pause button must be lit,
for these buttons to be operative.

Note: It is possible to configure the jog direction, see Option->System
setup.

Incremental Jog

Press this button to select Incremental jog mode.
Press the button a second time to disable Incremental jog mode.

Press the two arrows to move the tool head a large step.

Press the single arrow to move the tool head a small step.

 

The size of the incremental movement can be changed from Option->
System setup.
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Tool Down

Press the Tool Down button to manually operate the machine with a
tool in the down position.

Cancel by pressing Tool Down a second time.

Vacuum release mode

For details about this function, see separate chapter 'Vacuum control'.

If activated for more than 2 seconds, this button activates the Manual
Belt Clamp function.

6.4 High Pressure Air System

General 
The High Pressure Air System supplies the valves and tooling with compressed air.

The compressed air input is connected to a
combined Pressure Regulator Valve/Water
Trap.

Wall Outlet - Wall Outlet

A - Air Tube

R - Pressure Regulator Valve

P - Pressure Gauge

W - Water Trap

T - Air Tube to Tools and Valves

For details regarding air supply requirements, see Site Preparation Manual.

27
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Air Pressure Regulator settings

The air pressure should be adjusted to
minimum 6 bar (6 kg/cm2, 6*105 Pa).

Recommended pressure level is 7 bar (7 kg/
cm2, 7*105 Pa).

Consequences of too low air pressure level:

• Execution will stop.
• An error message is displayed.

6.5 Application Programs Available
After installation of iPC, the following application programs are available

iPC
Control program for the Cutting Table.
For more information, see User Manual for i-cut Production Console.

SysLoad
Program for download of updates to CU–modules

HWT900XP
Hardware test program, see separate HWT900XP User Manual.
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7. Basic Operations

Keep away from Moving Parts during operation.

Do not lean on Racks, Guide Ways or Traverse during operation, as this may
cause personal injury.

Before starting any operation, make sure that:

• The Table is free from obstructions
• No unauthorized personnel come close to the table

7.1 Introduction
All procedures for how to run the machine are based upon the following assumptions:

• The User Interface is up and running.
• The actual Tools are properly mounted and adjusted.

7.2 Power On Sequence

Ensure the table is free from obstructions and ready for operation.

Follow these steps to power up the system and get ready to work:

1 Front End PC

Switch on the PC and the monitor.

2 Table Power

Switch the table on using the Main Power Switch.

Note: After power off, wait minimum 5 sec. before the system is
switched on again.

3 iPC

From Desktop, double-click the icon for iPC

Check that no error message indicates faulty conditions.

4 Safety System

29
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Reset the Safety System by pressing the Pause pushbutton.

5 Servo Power

Press the Servo On pushbutton.

The Warning Lamp on top of the Y carriage should be on without
flashing.

6 Table Zero Sequence

Press Start pushbutton to complete the Table Zero Sequence.

The machine will move to the Selected Reference Point.

7 The table is now ready for operation.

7.3 Reset Safety System

Press Pause to Reset Safety System.

7.4 Power Off Sequence

Follow these steps to power down the system:

1 Servo Power

Press the Servo On pushbutton to switch Servo Off.

2 Table Power

Turn Table Power off using the Main Power Switch.

Note: After power off, wait minimum 5 sec. before the system is
switched on again.

3 Front End PC

To switch off the PC, use the Operating System shutdown procedure..

30
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7.5 Continue after Safety Break
If the Safety System is activated, all movements on the table are stopped and the Warning
Lamp starts flashing.

To continue operation, proceed as follows:

1 Ensure the table is free from obstructions and ready for operation.

2 Reset the Safety System by pressing the Pause pushbutton.

3 The Warning Lamp on top of the Y carriage should be on without
flashing.

Observe that Servo Power is switched on,

4 Press Start to continue.
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8. Prepare for a Job

8.1 Introduction

Keep away from Moving Parts during operation.

Do not lean on Racks, Guide Ways or Traverse during operation, as this may
cause personal injury.

Before starting any operation, make sure that:

• The Table is free from obstructions
• No unauthorized personnel come close to the table

The Starting Point in this procedure is to Create a Job from a file already available in My Jobs
List.

Detailed information about the complete iPC workflow is available in the following manuals:

• User Manual for i-cut Production Console.

• Get the best out of iPC 2.0.

Here, a step by step procedure is provided that can be used as a check list.

8.2 Create Job

In My Jobs List, double-click a file.

My Job Actions->Create Job.

A new Job is created based upon currently selected file in My Jobs List.

8.3 Layer Setup

Opened Job->Layers.

Ensure proper Layer Setup.
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8.4 Production Setup

Opened Job->Production Setup.

Verify correct Production Setup:

• Number of Copies
• Accuracy/Speed Prioritization
• Select Reference Point and Job Position
• Step and Repeat
• Registration
• Material Handling
• Tool Head Parking

8.5 Speed Setting

Opened Job->Production Setup->Quality.

Specify if this is a High Accuracy or a High Speed Job.

8.6 Flute/Grain Direction

Properties Bar->Flute/Grain Direction.

Verify that the Flute/Grain Direction corresponds to the material.

8.7 Vacuum Zone Selection

Machine Panel Toolbar->Vacuum Zones

From the Vacuum Zone setup – dialog, configure a suitable vacuum area for the job.

Select Vacuum Zones that corresponds to the outline of your material.
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Proper selection is important to achieve the best possible material hold down.

8.8 Job Execution
Before execution, check this:

1 Verify that Opened Job is ready for production.

2 Verify that the Table View display of the Job is reasonable.

3 Press Pause to reset Safety System.

4 Complete a Table Top Reference sequence to update Tool Height measurement.

5 Position the material on the Cutting Table.

6 Press Vacuum On to start the Vacuum Pump.

(If you are running with Automatic Vacuum Control enabled, the pump will start
automatically when Start is pressed)

7 Press Start to execute the Job.

8.9 Corrugated Production
Corrugated Production without Registration Marks is straight forward following the
procedure described in the Prepare for a Job - chapter.

Recommended tooling is described in Esko Tooling Guide.
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8.10 Milling Production
Milling Production without Registration Marks is straight forward following the procedure
described in the Prepare for a Job - chapter.

Recommended tooling is described in Esko Tooling Guide.

Note: Milling Jobs should be executed in High Quality mode.

8.11 Make a Pen Plot
Pen Plot without Registration Marks is straight forward following the procedure described in
the Prepare for a Job - chapter.

Ensure the Ballpoint Pen is clean and ready to use.
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9. How To Procedures, Advanced

9.1 Cutting Thick Materials
When preparing materials with thickness between 45 – 50 mm (1¾ - 2 in.), the following rules
apply:

• No Camera operations are available.

• Disable Measure Material Thickness.

• Disable the Depth Referenced from Top function.

• This function is for Knife Tools only.

Follow the procedure described in the Prepare for a Job - chapter.

Cutting Depth when Depth Referenced from Top is disabled

Note: This function is useful for all materials with an un-even surface.

9.2 Hard Board Production

To prepare hard board materials, the
procedure is as follows:

1. Mill through the top layer using HPMU.
2. Cut through the mid-section using the MP

HF VibraCut Knife.
3. Mill through the bottom layer using HPMU.

• Ensure that the router bit is sharp and proper for the job.
• Ensure that the Knife Blade is sharp and proper for the job.
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9.3 Multi Pass Creasing or Milling

1. pass 2. pass 3. pass - mill through and clean
the path

Multi Pass Creasing is beneficial if you want a deeper crease path.

This is achieved by running one pass with for example 50% depth and a second pass with 70%
depth.

Multi Pass Milling is beneficial if you want to mill through a material where the thickness is
bigger than the router bit diameter.

Multi pass creasing or milling is available by modifications in the Opened Job->Layer structure.

Proceed as follows:

1. Identify the Layer containing the crease or milling line(s) where Multi Pass is wanted.
2. Make one or more copies of the Layer including geometry.
3. The Layers will be executed in the listed sequence.
4. In the Layers, update the depth values to suitable steps.

For execution, follow the procedure described in the Prepare for a Job - chapter.
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9.4 Jobs including Reverse Operations

Step 1 - the sheet is aligned towards the Right
Ruler.

Reverse Operations are completed.

Step 2 - the sheet is aligned towards the Left
Ruler.

The rest of the job is completed.

A typical use of Reverse Operation is when you want to add a crease line on the front side of
a material that you normally prepare from the rear side.

Reverse Operation is available by modifications of the actual Layer.

This function requires that the table is equipped with Left and Right Rulers.

Note: Reverse Operation is not available on machines with conveyor belt.

Reverse Operation in combination with Step and Repeat
For each copy defined by Step and Repeat, you have to move the sheet; first against the Right
Ruler, then against the Left Ruler:
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9.5 Work with different Reference Point Settings
Select the Reference Point to use from:

Opened Job->Production Setup->Position->Reference Point

For more information, go here.

9.6 MultiZone Production

Introduction
In User Manual for i-cut Production Console, general information about MultiZone
Production is available.

In this chapter, XP - specific issues are described.

MZP Panel
Each work zone is equipped with a panel that makes it possible to run the complete MultiZone
Production sequence from the table.

39



9 Kongsberg XP

• 1 - Ready Lamp

• 2 - Ready Button

• 3 - Vacuum on Button

• 4 - Vacuum Lamp

Vacuum Zones
Vacuum Zone Configuration on page 50

MultiZones

The illustration shows the most actual zones available for MultiZone Production.

Limitations

Work Areas on a MultiZone table

If you have a standard Cutting Table, prepared for MultiZone Production, this limitation is
valid.

If your table is modified for two equal zones, where W = 1600 mm / 63 in, please disregard this
limitation chapter.
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The last section of a multizone table is
somewhat smaller than the first one(s).

As a consequence, the work area available for
MultiZone Production is determined by the
size of the last section.

W(XP24) =
W(XP44) =

9.6.1 MultiZone, Workflow

 - Recommended material flow direction.

 - Attention Area.

During operation in one zone, parts of the traverse will move into the other zone (photo cell
beams, traverse end cover).

To ensure a continous workflow, the operator should be very careful inside the Attention
Area, not to trigger the safety system by his body or by material in and out.

Thus, we recommend loading and unloading material from the front- and back end of the
table.
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10. System Setup

10.1 Introduction
This chapter will explain functions and parameters that are important for the XP system to run
properly.

It is a supplement to the information available from the User Manual for i-cut Production
Console.

Examine each step carefully to ensure proper settings:

One time adjustments completed at the factory
The functions are included here as a reference.

They are not used during normal operation.

If necessary, they should be repeated, as indicated in the function description.

1 Adjust X1 to X2 Angle

2 Register Table Size

3 Adjust Measuring Station Position

4 Set Ruler Position

5 Set Main Reference Point

6 Map Table Top Surface

7 Calibrate Foot on Measuring Station

8 Vacuum Setup

9 Router Setup

Adjustments to customize the table

1 Select Reference Point

2 Set Table Speed

3 Set Table Acceleration
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4 Jog Settings

5 Set Table Top Reference

6 Conveyor Belt Control

7 Board Size

10.2 Adjust X1 to X2 Angle

Machine Connection->Machine Configuration->Installation_>Adjust X1 to X2
Angle

Use this wizard to obtain correct angle between X axis and Y axis.

Typical use is after maintenance or repair.

Procedure:

1. Execute the Adjust X1 to X2 Angle
function.

2. Follow the instructions exactly as given by
the wizard.

Note: Select a set of drilled vacuum holes (1
and 2) in the table top as reference.

10.3 Register Table Size

Machine Connection->Machine Configuration->Installation_>Register Table Size

This wizard moves the Tool Head from edge to edge of the Cutting Table in order to measure
the table size.

Typical use is after maintenance or repair.

Procedure:

1. Execute the Register Table Size function.
2. Follow the instruction given by the wizard.
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10.4 Adjust Measuring Station Position

Machine Connection->Machine Configuration->Installation_>Adjust Measuring
Station Position

Use this wizard to calibrate the position of the Measuring Station to the system.  

Typical use is after maintenance or repair.

Procedure:

1. Press the Adjust Measuring Station Position button.
2. Follow the instruction given by the wizard.  
3. Repeat this procedure after maintenance on the Measuring Station.

10.5 Set Ruler Position

Machine Connection->Machine Configuration->Installation_>Set Ruler Position

Follow instructions from the wizard.

If your table is equipped with Rulers, please complete the wizard for Left and Right Ruler.

For the table to operate properly an exact registration of the Ruler Positions is necessary.

This is a one time job, but it can be necessary to repeat the procedure if mechanical
maintenance has been carried out on the table or traverse.

Correct registration of the Right Ruler is required when Reverse Operations are carried out.

10.6 Set Main Reference Point

Machine Connection->Machine Configuration->Installation_>Set Main Reference
Position

Follow instructions from the wizard.
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Use this wizard to establish the Main Reference Point (R).

Typical use is after maintenance or repair, if the Main Reference Point has been accidentially
moved.

The Main Reference Point is a fixed position on the Cutting Table marked as a cross of drilled
holes.

For more information, go here.

10.7 Map Table Top Surface

Machine Connection->Machine Configuration->Installation_>Map Table Top
Surface

To assure correct Cutting Depth, the surface of the Table Top is measured in order to create a
map.

It is recommended to execute this function if the Cutting Mat is worn out and after the
Cutting Mat has been replaced.  

Procedure:

1. If the table is equipped with a Conveyor Belt, move the belt junction away from the table
surface.

2. Execute the Map Table Top function.
3. Follow the instructions given by the wizard.
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Note:

iPC 2.1: The mechanism of compensating Z height during cutting, based on table top mapping,
has been disabled when cutting underlay has been measured to be more than 5mm.

This level is normally reached when milling on top of milling mat and conveyor belt.

This exception was introduced long time ago, before using conveyor belts.

At that time, a (MDF) plate was used as milling underlay. The plate was milled in order to make
a perfectly compensated underlay for milling.

As this function is not used anymore, and conveyor belts break the 5 mm limit, iPC now always
compensate based on table top mapping.

A registry setting is available to enable the old behavior.

10.8 Calibrate Foot on Measuring Station

Machine Connection->Machine Configuration->Installation_>Calibrate
Measuring Pad

Use this wizard to calibrate the height level of the Measuring Station.  

Typical use is after maintenance or repair; to ensure the tool height measuring system works
properly.

Procedure:

1. Press the Calibrate Foot.
2. Follow the instruction given by the wizard.  
3. Repeat this procedure after maintenance on the Traverse, Carriage or Measuring Station.

10.9 Reference Points and Coordinate System
Reference Points settings is maintained from:

Menu Bar->Edit->Options...->Reference Points

All X and Y coordinates in the Input File have the selected Reference Point as origin.

Two modes of operation are available:

• Using Main Reference Point

• Using User Defined Reference Point
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The Main Reference Point position

The Main Reference Point is a fixed position on the Cutting Table marked as a cross of drilled
holes.

The User Defined Reference Points are all specified relative to the Main Reference Point.

Thus, moving the Main Reference Point will move these reference points as well.

The Main Reference Point has to be correctly positioned in order to obtain:

• A full Work Area.
• Correct Sheet Feed operation.
• Correct handling of Long Jobs

Using the Main Reference Point during program execution ensures correct operation.

User Defined Reference Points

You can specify User Defined Reference Points.

User Defined Reference Points are used if you want your job positioned in a fixed position on
the table (Rx), but not in the Main Reference Point (R).

A special version of User Defined Reference Point is the Panel Reference Point.

1 Position the Laser Pointer in the position where you want your Panel
Reference Point.
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2 Press the Set Panel Reference Point button on Operators Panel.

The Panel Reference Point is set to current Laser Pointer Position

Rulers and Reference Points

The Ruler System ensures an easy and correct
positioning of the material on the table.

The Main Reference Point shall be defined dr
= 10 mm/0.39 in. inside the ruler.

When you use the Right Ruler, the Reference
Point will automatically be moved to an
identical distance from the Right Ruler, as it is
defined from the Left Ruler.

The Right Ruler is normally used for Reverse
Score operations. At the same time the
direction of the X axis is reversed.

10.10 Table Speed

Menu Bar->Advanced->Configure Tools...->Velocity X/Y

This is the default value for each Tool when Layers are created.

Opened Job->Edit Layer->Speed X/Y

Modify Speed for this particular Job.

Opened Job->Production Setup->Quality

Here you specify if this is a High Quality Job or High Speed Job.
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10.11 Table Acceleration

Menu Bar->Advanced->Configure Tools...->Acceleration

This is the default value for each tool when Layers are created.

Note: Acceleration can be reduced to a % value of the maximum acceleration
available.

Opened Job->Layers->Edit Layer->Acceleration

Modify acceleration for this particular Job.

10.12 Jog Settings
Continuous Jog speed

The Continuous Jog Speed can be reduced to a % value of the maximum jog speed:

Machine Connection->Machine Configuration->Setup_>Jog Speed

Specify low and high Jog Speed

Incremental Jog Step Size
The size of the Incremental Jog movements can be customized.

Machine Connection->Machine Configuration->Setup_>Incremental Jog

Specify Step Size to be used.

Jog Directions
Machine Connection->Machine Configuration->Setup_>Jog Panel Direction

Use this function to align the Jog Directions with the orientation of the Operator
Station.

10.13 Set Table Top Reference

Menu Bar->Machine->Set Table Top Reference

Follow instructions from the wizard.

Machine Connection->Machine Configuration->Installation_>Table Top
Reference
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Follow instructions from the wizard.

Machine Panel Toolbar->Table Top Reference

Use this function to complete a Tool Height Reference calibration.  

The Tool Height is measured in current position and the reference to the table top surface is
updated.

This calibration is the basis for Tool Height calculation.

The Table Top Reference function should be carried out:

• After mechanical adjustments of traverse or tool head.
• When cutting through material is not working properly.
• After any change of cutting / milling underlay, for instance, after adding or removing the

milling underlay.

Procedure:

1. Remove all materials from the table surface.
2. Measure on top of the cutting underlay or conveyor belt.
3. If the table is equipped with a conveyor belt, avoid measuring directly on the belt junction.
4. Execute the Table Top Reference function.
5. In the wizard, press OK to start measurement.

10.14 Vacuum Setup

10.14.1 Vacuum Zone Configuration

Machine Connection->Machine Configuration->HW Configuration->Vacuum
Setup
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This is a dialog where the Vacuum Zone Configuration for the actual machine is specified.  

This setup is a one-time job as long as the Vacuum Zone Solution on the machine remains
unchanged.

The setup should correspond to the actual hardware.  

The selected setup will determine which Vacuum Zone Configuration that will be available in
the User Interface.

Machine Zone Configuration Vacuum Configuration
XP20 #7

XP24 #2

XP44 #2
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10.15 Router Setup

Machine Connection->Machine Configuration->HW Configuration->Router Setup

From the Router Setup dialog, maintain the following parameters:

Specify Router
If a Router is mounded, spedify Router Type.
If no Router is mounted, select None

COM-port
The physical COM-port used for communication with the Router Control Unit is specified.
Note: The Router Control Unit needs to be connected to a genuine COM port. If connected
to a USB-to-COM adapter, the communication will fail.

These functions are used only after a hardware modification.

10.16 Conveyor Belt Control

Machine Connection->Machine Configuration->HW Configuration->Conveyor

Specify if the machine is equipped with Conveyor Belt.

10.16.1 Split Sheet Feed

Sheet in Load Position Sheet Load, step 1 Sheet Load, step 2

In some occasions, the sheet unloaded from the cutting table can trigger the photo cell safety
system.

To avoid this, the sheet feed movement is divided into two steps.
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10.16.2 Sheet Feed Correction

If the Conveyor Belt feed length needs adjustment, use this function to adjust the movement
of the Conveyor Belt to be shorter or longer.

10.17 Board Size
Not implemented yet
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11. Tool Configuration and Adjustment

Machine Connection->Tool Configuration

The Tool Configuration dialog is used for all tool settings and adjustments.

Select tool and function.

11.1 Tool Configuration
The XP machine offers two different tool positions, P1 and P2, where different interchangeable
tools can be mounted.

In addition, there are separate fixtures for Laser Pointer, Measuring Foot, Camera, Drill and
Pen Tools:

 

L - Laser Pointer

M - Measuring Foot
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P1 - P1 tool position, see table below

C – Camera position

P - Pen / Drill / Ink Tool holder position

P2 - P2 tool position, see table below

The following tool configurations are available:

Tool Type Available Tool Inserts P1 P2
HDU - Heavy-Duty Unit HD Crease, V-notch Knife, HD Knife

Tool
Yes  

FCU - Foam Cutting Unit   Yes  
HD Knife Tool   Yes  
HPMU – High Power Milling Unit   Yes  
VibraCut Knife Tool     Yes
HF VibraCut Knife Tool     Yes
HiForce Knife Tool     Yes
RM Knife Tool     Yes
RotaCut Knife Tool     Yes
PressCut     Yes
       
Drill/Pen Holder Drill Tool, Ballpoint Pen, Ink Tool

(Fibertip Tool)
   

11.2 Tool Names

Factory Tool Name
The Tool Type mounted is identified by hardware codes inside each tool.

The identified tool is called Factory Tool Name

The mounted tools are maintained by:

Machine Connection->Tool Configuration
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Current tool configuration is displayed under Identified tools.

When a new tool is inserted, it will be identified to the system automatically.

By default the system creates a username from the tool type and its serial number. E. g. a knife
with serial number 3020 will be named Knife 20

User Tool Name

Menu Bar->Advanced->Configure Tools

From this dialog, you can give each tool a nickname.

11.3 Adjust Active Tool

Machine Connection->Configure Tools->Adjust Selected Tool

Follow instructions from the wizard.

From the Adjust Selected Tool – dialog, all Tool Adjustment Wizards are executed.

The following procedures are general descriptions of how to adjust the tools.

See the description of each Tool Type for more specific information:

We recommend using a sheet of Folding Carton material, 5-6 mm / 0.2 inch, when executing
the adjustments.

Note: All tools need to be adjusted in the position they will be used.

Before any adjustment, complete a Table Top Reference function.

11.4 Lag Settings (for Rotating Tools)

Machine Connection->Configure Tools->Adjust Selected Tool->Lag Settings

Follow instructions from the wizard.
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1. In the Configure Tool dialog, select the Tool to be adjusted.
2. Press theAdjust Active Tool button to enter the Wizard

Selection dialog.
3. Select Lag Settings
4. Follow the instructions given to enter correct values.
5. Repeat the procedure for all rotating tools.

Lag Test
Machine Connection->Configure Tools->Adjust Selected Tool->Lag Settings->Lag
Test

Run this wizard to obtain correct Knife Lag value.

Follow the instructions in the dialog.

Add the measured value to the displayed value.

Circle Lag  
Circle quality is determined by a parameter called Circle Lag. The parameter value will vary
depending upon the actual material.

Therefore, the adjustment is located in the Opened Job->Edit Layer dialog
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11.5 Tool Height Calibration

Machine Connection->Configure Tools->Adjust Selected Tool->Tool Height
Calibration

Follow instructions from the wizard.

C systems are equipped with Automatic Tool Height Calibration.

Thus, the system will run without any manual height calibration.

If you would like to add an offset to the measured height, use the Tool Height Calibration
dialog:

1. Select the Tool to be adjusted
2. Press the Adjust Active Tool button to enter the wizard selection dialog.
3. Select Tool Height Calibration
4. Follow the instructions given by the wizard, step by step.
5. Repeat the procedure for all tools.

Typical use of this function is to add depth in order to ensure proper through-cut in difficult
materials.

11.6 Rotation Adjustment (for Rotating tools)
Optimal Angular Offset may vary with different material strength and thickness.

The adjustment can be done using the adjustment wizards, or by a manual adjustment
procedure:

Adjustment using Wizard
Machine Connection->Configure Tools->Adjust Selected Tool->Rotation
Adjustment
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1. Select the Tool to be adjusted.
2. Press the Adjust Active Tool button to enter the wizard selection dialog.
3. Select Rotation adjustment.
4. Follow the instructions given by the wizard, step by step.
5. Repeat the procedure for all Tools mounted.  

Manual Adjustment
Machine Connection->Configure Tools->Adjust Selected Tool->Manual
Adjustment of...

Follow instructions from the wizard.

1. Place an appropriate test material on the table, and switch Vacuum On.
2. From Machine Connection->Tool Configuration, select one Tool.
3. Press Adjust Active Tool to enter the Wizard Selection Dialog.
4. Select Manual Adjustment of Center Offset and Angle.
5. Enter value for the Angular Offset and select Activate.
6. Note that the Tool will rotate as the new value is activated.
7. Press Tool Override Down, and Jog approximate 10 cm to make a test cut.
8. Press Tool Override Down once more to lift the Tool again.
9. Press Tool Override Down once more to lower the Tool again.
10.Note how the knife enters into the material.
11.Press Tool Override Down once more to lift the Tool again.
12.If knife enters exact into the cut, the angle is correct; select Finish to exit.
13.If seen in the cutting direction, the knife enters to the left of the cut, the Angular Offset

Value should be decreased. Repeat from point 5.
14.If seen in the cutting direction, the knife enters to the right of the cut, the Angular Offset

Value should be increased. Repeat from point 5.

11.7 Center Offset Adjustment
The adjustment can be done using the Adjustment Wizards, or by a Manual Adjustment
procedure:  

Adjustment using Wizards
Machine Connection->Configure Tools->Adjust Selected Tool->Center Offset
Adjustment
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1. Put an appropriate test material, that means a thin paper on the table (any significant
material thickness will create a misleading offset in this wizard), and switch vacuum on.

2. Select the Tool to be adjusted.
3. Press the Adjust Active tool button to enter the wizard selection dialog.
4. Select Center Offset Adjustment.
5. Follow the instructions given by the wizard, step by step.
6. Repeat the procedure for all Tools mounted.  

Manual Adjustment
Machine Connection->Configure Tools->Adjust Selected Tool->Manual
Adjustment of...

Follow instructions from the wizard.

1. Place an appropriate test material on the table, and switch Vacuum On.
2. From Machine Connection->Tool Configuration, select one Tool.
3. Press Adjust Active Tool to enter the Wizard Selection Dialog.
4. Select Manual Adjustment of Center Offset and Angle.
5. Enter value for the Center Offset and select Activate.
6. Note that the Tool will move as the new value is activated.
7. Press Tool Override Down, and Jog approximate 10 cm to make a test cut.
8. Press Tool Override Down once more to lift the Tool.
9. Press the Jog button for the return direction shortly, just to turn the Tool.
10.Press Tool Override Down once more to lower the Tool, and Jog the same distance back.
11.Press Tool Override Down once more to lift the Tool.
12.The two cuts should follow exactly the same path.
13.If exact, the Center Offset is correct, select Finish to exit.
14.If not, modify the Center Offset Value and repeat from point 6.

11.8 Tool Offset

Machine Connection->Configure Tools->Adjust Selected Tool->Offset Adjustment
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The Laser Pointer is the reference:

1. Place an appropriate test material on the table, and switch Vacuum On.
2. From Machine Connection->Tool Configuration, select one Tool.
3. Press Adjust Active Tool to enter the Wizard Selection Dialog.
4. Select Offset Adjustment.
5. A cross is made by the Tool to be adjusted.
6. The Laser Pointer is positioned in the center of the cross.
7. If necessary, jog the Laser Spot into the center of the cross.
8. Follow the instructions given by the wizard, step by step.

11.9 Maintain Tool List

Machine Connection->Configure Tools->More...

The More... dialog contains selections to Ignore, Delete or Add to the Tool List.

The Tool List contains Tools that you can select for the available Tool Positions.

Ignore Automatic Tool Identification
Ignore Automatic Tool Identification may be used when the Automatic Tool Detection fails,
and manual tool selection is necessary.

If Ignore Automatic Tool Identification is checked, Tool Setup remains unchanged after:

• Table Zero Position sequence

• Identify Tools function

Delete Tool
Use Delete Tool when a Tool is no longer in use.

The deleted Tool will no longer be available in the Tool List in the Edit Layer dialog.
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Add Tool
Use Add Tool to

• Add new Tools

• Add tools that fails during Automatic Tool Detection

The Tool is added to the Tool List.
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12. Tooling System

12.1 Introduction

Knife Blades are extremely sharp.

Take care when handling Knife Tools.

Laser Radiation.

Do not stare into beam!

The tool head is equipped with a class II laser pointer. Emitted laser
power < 1 mW.

In this chapter, all tools are explored:

• General description
• How to operate
• How to adjust

12.2 Tool Handling and Care
All Tools are precision instruments and should be treated as such to ensure proper operation.

Take special care when:

• Tools are inserted or removed
from their stations. No excessive
force should be applied.

• Tools should not come in
contact with hard surfaces while
removed from their stations either
temporarily or for storage.

• The Tools and their stations
should be kept clean with a soft
brush.

63



12 Kongsberg XP

12.3 How to Replace a Tool

When mounting a tool onto the P1
or P2 Tool Positions, ensure that
the Guide Pins and the electrical
connector fits those on the bracket.  

Use an Allen Key, 6 mm, to fix the
tool.

Ensure both screws are properly
fixed.

12.4 Two or more tools of the same type
Each tool is identified to the system by Tool Type.

In addition, it is possible to identify up to four different tools of the same type.

One example:

If you have two different Static Knife Tools, you can specify one to be number 1 and one to be
number 2.

In this way, all Adjustment Parameters will be stored and recalled automatically as the tool is
mounted onto the machine.

How to define individual Tool Numbers
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Inside each Tool, there is a Tool Board.  

By means of dip-switches, you can specify 4
unique Tool Numbers.  

The different Tool Numbers are defined as
follows:

Tool Number Tool Board switch setting
Tool 1 1 & 2 off
Tool 2 1 on & 2 off
Tool 3 1 off & 2 on
Tool 4 1 & 2 on

Note: There are some restrictions, see Technical Manual for more information.

12.5 Measuring Station
XP is equipped with a Measuring Station:
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The Measuring Station eliminates the manual
adjustment of tool height. 

The Measuring Station covers the following
functions:

• Calibrates the Measuring Foot.

• Automatically measures the height of the
tool tip.

If you, for any reason, would like to add an
adjustment value to the measured value, a
height adjustment dialog is available from the
Tool Configuration menu.

 The Measuring Sequence is carried out as follows:

• During the first Table Zero Sequence after Power On.

• After any Tool change and the Tool is not calibrated.

• After the Safety System has been broken for 30 sec. or more.

• After the Servo System has been off for 30 sec. or more.

• During the Table Zero Sequence if Incremental Jog is selected.

Tool Depth and Measuring Station

Be aware how the Measuring Station is
working; it is the tool tip that is measured.

Depending upon the actual tool, it might be
necessary to add depth in order to achieve cut
or drill through the material.

Additional depth is entered in two ways:

• The general depth of a Tool is entered
from Machine Connection->Configure
Tools->Adjust Selected Tool->Tool Height
Calibration.

• The Job specific depth is entered from
Opened Job->Edit Layer
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12.6 HDU - Heavy-Duty Unit

HDU with ø150 mm Crease Wheel

The Heavy-Duty Unit is a single position Tool Head specially prepared for V-notch and HD
Knife tools.

In addition, the Tool Head can be equipped with a ø150 mm Crease Wheel, crease adapter
and perforation wheel.

For detailed description, see separate chapters for

• V-notch Knife
• HD knife tools
• ø150 mm Crease Wheels
• Crease Adapter
• Perforation Wheel ø60 mm

12.6.1 Crease Wheel ø150 mm

Description

A ø150 mm Crease Wheel mounted
on an Heavy-Duty Unit.

This Crease Wheel has the
equivalent of 50 kg [110 lbs] of down-
pressure.

The additional pressure, combined
with the large frontal area of the
big wheel enables excellent crease
quality in heavy-duty Corrugated
Board and even permits creasing
board with high recycle content
without breaking the liner.
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A broad range of Crease Wheels
with different shapes is available.

How to mount / dismount Crease Wheels
Insert / remove the Latch Pin.

Insert / remove the Cotter Pin.

Tool Adjustment
For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Lag value depends upon the Blade Adapter.

Nominal value is 0 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter
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12.6.2 V-notch Knife Tool

Description

The V-notch Knife Tool mounted on a Heavy-Duty Unit.

How to insert / remove the V-notch Knife Tool

i

1 Turn the V-notch Knife Tool
correctly to fit the Guide Pin.

2 Insert the two Latch Pins.

3 Insert the Cotter Pins.
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How to replace a Knife Blade
This picture shows how the Knife
Blade is aligned using two Guide
Pins (a and b) beneath the blade
clamping.

1. Loosen the two screws (b) of the
Knife Blade clamping.

2. Carefully remove the blade (a).
3. Insert a new Knife Blade and

make sure that it is aligned with
the Guide Pins (c).

4. Mount the new tool. (Note the
position of the Guide Pin).

5. Ensure that the tool height is
calibrated on the Measuring
Station.

About Tool Adjustment

• For the V-notch Knife, we recommend the manual procedures for Tool Rotation and
Center Offset adjustment.

• When adjusting Tool Rotation and Center Offset, use a thin Folding Carton material.

• Remember that you should look at the bottom side of the material for correct alignment.

• The adjustment depends upon the actual material due to weight, structure and thickness.
• For optimal result, a fine tuning of the adjustments in the actual material should be carried

out.

For this Tool, complete the following adjustments:

Adjustment Description
Lag Setting The Knife Lag depends upon the Blade Adapter.

Nominal value is 0-7 mm.

Tool Height Measured automatically, possible to add an Offset Value
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

70



12Kongsberg XP

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

How to set the depth of the V-notch Knife

1. The default depth of the V-notch Knife is cut through the entire material.
2. To make adjustment to the depth, go to Opened Job->Edit Layer.
3. Normally the cut should extend down to just above the Bottom Liner.

How to run the Triple Cut Function
To set the Triple Cut Function, go to Opened Job->Layer Setup.

V-notch Knife Cut Direction

The blade angle and the cut direction must be taken into account when cut jobs are prepared.  

The arrow indicates the Cut Direction.

Different angles
A wide range of V-notch knives is available, providing different
knife angles, v: 15o, 22.5o, 30o, 45o, 47.5o.

V-notch Knife Tool, Modes of Operation

Opened Job > Layers Tab > Edit Layer

Menu Bar->Layer->Edit Layer...
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Note:

V-notch Knife Adapters are available for
different knife angles: 15o, 22.5o, 30o, 45o,
47.5o .

In this chapter, a 45o knife angle is discussed.

The programming and operation will be similar
for other angles.

Modes of Operation

Single Cut

Double Cut

This is the default mode if neither Single Cut
nor Triple Cut are enabled.
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Triple Cut Function

To ensure proper folding of rigid materials,
use this function to remove material from the
middle of the cut.

Note:

• This function is working along Y only. Flute
direction must be along Y.

• The numbers indicates sequence of
operation.

This illustration shows a typical use of Triple
Cut Function.

The middle wall is not cut by (2) or (3), making
the material impossible to fold.

The Triple Cut Function (1) cut the middle
wall and you can fold the material nicely.

Geometry

When the knife angle is 45o and you cut
through the material, the width of the cut is W
= 2 x h.

Folding

If you prepare a material for folding, the following rules applies:

• Adjust the cutting depth to just above the bottom liner.
• Adjust the cutting width (W) by the adjustment parameter dW. Nominally, the width of the

cut has to be increased by dW = - 2 x bottom liner thickness.
• dW limitations: -20 mm < dW < 20 mm / -0.8 in < dW < -0.8 in.
• Decide if Triple Cut Function is needed.
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This illustration shows how the parameter dW is used to ensure a nice folding result.

Triple Cut Function, adjustment

Adjustment sign and cut direction

12.6.3 HD Knife Tool

Description

The HD Knife Tool mounted on HDU.

The HD Knife Tool is used for rigid board such as ReBoard and Triple Wall material.
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The Tool is limited to Straight Lines longer than 50mm (2”).

The Tool is prepared for special, trapezoid shaped Knife Blades.

How to replace a Knife Blade
This picture shows how the Knife
Blade is aligned against two Guide
Pins.

Use these two screws to fix / release
the Knife Blade.

How to insert / remove the HD Knife Tool
1 Turn the HD Knife Tool correctly to
fit the Guide Pin.
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2 Insert the two Latch Pins.

3 Insert the Cotter Pins.

Tool Adjustments
For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Knife Lag depends upon the Blade Adapter.

Nominal value is 10 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

12.6.4 Crease Adapter

Using a Crease Adapter allows for smaller crease wheels used on HDU.

Adapters are available for ø15mm and ø26 mm crease wheels.
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12.6.5 Perforation Wheel ø60 mm

Use Perforation Wheel to prepare perforation lines at high speed.

Suitable for corrugated board up to C flute (4 mm/0.16 in.).

Perforation Wheel assembly
Parts in assembly

Ensure the path is clean.
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Fix cover properly.

Push / pull the perforation wheel in / out from
the adapter.

Tool Adjustment
For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Lag value depends upon the Blade Adapter.

Nominal value is 0 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter
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12.6.6 Bevel Knife 45

Bevel Knife is a special-purpose tool for 45
degree angled cuts.

Lag = 3.5 mm / 0.14 in.

How to replace a Knife Blade

• Loosen the two screws holding the blade
clamp.

• Pull out the old Knife Blade.

• Insert the new blade.

• Ensure the blade align exactly with the
alignment pins.

• Fix the blade clamp.

At left, the clamp is removed just to show how
to align the Knife Blade.

After a blade change, the tool depth should be checked again.

How to set the cutting depth of the Bevel Knife
The default cutting depth for Bevel Knife is cut through the entire material.  

Define the depth of the bevel cut in the Layer Setup.  

Normally, the cut should extend down to just above the bottom liner.

About tool adjustment
For the Bevel Knife, we recommend the manual procedures for tool rotation and centre offset
adjustment.  

Use a thin Folding Carton material when adjusting tool rotation and centre offset.  

Remember that you should look at the bottom side of the material for correct alignment.  

The adjustments depend upon the actual material due to weight, structure and thickness.
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For optimal result, a fine tuning of the adjustments in the actual material should be carried
out.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

12.7 Foam Knife
Description

The Foam Knife Tool Head is
mounted onto the P1–position.

Note:  Be careful where to place the Foam Knife Tool when not in use.

If the Tool Head is left on a table surface, the Knife Blade might be exposed, as the material
hold down wheels moves up.
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How to replace a Knife Blade

Loosen the fixing screw, replace the Knife
Blade and fix it again.

No additional adjustments are necessary, as
the tool height is measured automatically.

A set of Knife Protection Handles are
available.

Use them for safe knife handling.

When not in use, protect the Knife Blade
using the handle.

How to replace the Knife Adapter

Loosen the fixing screw, replace the adapter
and fix it again.

No additional adjustments are necessary, as
the tool height is measured automatically.

Disable Material Thickness Measurement

Opened Job->Layers->Edit Layer.

For the Foam Knife Tool, the Disable Material Thickness Measurement function is available.
Use this function if:
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1. Your foam material is too soft for the measuring system.
2. The surface of your material is un-even.

When the Disable Material Thickness Measurement function is enabled, the following rules
applies:

• Depth is referenced from bottom (top of cutting underlay).
• During Tool Up movements, the knife is lifted to its top position.

Cutting Quality
To obtain best quality when cutting details, as small circles, we recommend:

• Reduce the Cutting Speed (from Opened Job->Layer).

• Cut in two or three passes, each pass going a step deeper (Multi Pass).

Tool Adjustment
For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Knife Lag depends upon the Blade Adapter.

Nominal value is 3 (5) mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

12.8 HPMU - High Power Milling Unit

12.8.1 Introduction

Spindle motor
Power rating (max) 3 kW
Cooling system Liquid cooling
Shank size (max) 8 mm
RPM (max) 60000
Tool change Pneumatic
Vibration sensor board No
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HPMU chucks

Different chucks are available from http://
www.esko.com/en/store/kongsberg-bits-blades/

Replacing a chuck

Replacing a chuck is described in detail in Chuck Change and Cleaning on page 96.

This chapter is included just to remind you how important it is to use the Chuck Changing
Tool available and a dummy bit to ensure correct mounting:

From left:

Chuck tool, dummy bit with
right diameter for the chuck,
and chuck.

Chuck change assembly. Ready to be inserted into the
spindle.
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12.8.2 Tool Head description

1. Suction House with brush for chip removal.
During normal operation, the house is
in down position. When changing bit,
the house should be locked in its upper
position.

2. Air Blow adjustment. Air Blow is used
for Router Bit cooling and to ease chip
removal. Adjust for proper operation.

3. Chuck Open/Close. The shown position is
closed.

Note:  To protect the chuck from damage
and the spindle from contamination, do not
close the chuck over time without a dummy
bit inserted.

Never start the spindle without a bit /
dummy bit in the Chuck.

4. Warning Lamp for spindle running.
5. Air Clean Button to help remove

contamination.
6. Locking Screw for the suction house.

1. Router Bit.
2. Chuck. The HPMU is equipped with one 6

mm chuck on delivery.
3. Spindle
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HPMU Park Position

A HPMU Park Position is available on the
gallows stand.

Use the park position for safe HPMU Tool
Head storage.  

Note: For safety reasons, always insert a
Dummy Bit when parking.

Chiller / HPMU start up time
Depending upon the environmental temperature, the Chiller needs some start-up time after
Power On before it is ready to operate.

Typical delay is 2 – 3 minutes.

Suction House, adjustable height

On HPMU, you can lock the Suction House in
any height; still, it is allowed to move upwards.
 

This function is useful in order to:

1. Adapt to different material thicknesses.
2. Allow false air input in order to reduce

suction force.

Procedure:

1. Loosen lock screw (a).
2. Adjust suction house to desired height.

Spindle RPM limitations
Running 8 mm bits at a high RPM rate can generate vibrations and excessive wear.

Using Milling Bits with extended length at high RPM can also be dangerous.

Therefore, using long Milling Bits is subject to an automatic RPM reduction.

If you are using short 8 mm bit, these must be limited manually to 40.000 RPM.
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In general, 6 mm bits are preferable in materials up to 20–25 mm thickness.

12.8.3 Safety Issues

Unattended Operation

Depending upon the material processed, milling introduce some risks.

It is a good rule to keep an eye on a milling job being executed.

Pay special attention to:

• Do not leave the machine running if the Vacuum Cleaner can be over-filled. This might
cause damage.

• Ensure the filter inside the Vacuum Cleaner is cleaned regulary.
• Be aware the risk of suction tube clogging.
• Be aware the risk of suction house clogging.
• Milling MDF or other fine dust materials requires extra attention in order to keep the

Vacuum Cleaner filter clean.

Vacuum Cleaner full

• Follow the Vacuum Cleaner filling level carefully.
• Empty the container before the level reach the inlet position (indicated in red).

Suction House

Always, when executing a job, let the Suction House float on top of the material.

In addition to chip removal, the house reduces the risk of being hit by small work pieces or by a
broken Router Bit.

Eye protection
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Use eye protection when working with HPMU.

Hearing protectors

The noise generated by milling varies with the material being processed, and running
parameters. Use hearing protectors when necessary.

Spindle speed

Never use speeds higher than recommended by the bit supplier. Special care should be taken
when using bits with cutting diameter larger than shank diameter.

Router bits

Router bits are very sharp – handle with care.

Never touch a rotating bit. Ensure the warning lamp is dark, and also observe that the
bit is not rotating before approaching the bit.

Always insert a dummy bit before dismounting a tool head from the machine.

High temperatures

Be aware it is normal that the HPMU appears to be hot during operation.

Clean surface

Keep the table and material surface clean, free from obstacles.

12.8.4 Precautions

Spindle Motor Power Consumption Supervision

Machine Panel->Spindle Power

The HPMU spindle is prepared for continuous operation between 0 – 100 % Watt.

A power load of 70-80% will allow good working conditions for the Spindle Motor.

Too high Spindle Power consumption indicates critical conditions for the motor and
immediate actions should be taken:

1. Use correct and sharp milling bit.
2. Use correct RPM for the actual bit and material.
3. Reduce the X/Y speed.
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If the motor is running above a critical limit, the execution will stop and a message is displayed.

Use of Non-Balanced Bits

One-flute bits are by nature Non-Balanced,
and may destroy the Spindle if used wrong.

Therefore, one-flute bits with cutting
diameters above 4 mm, 5/32 inch, must be run
with a maximum RPM of 40.000 (HPMU)

Keep distance d small

For best performance and minimum wear, do not let the bit extend out from the chuck more
than necessary.

Use bits with short cutting lengths for thin materials.

Chuck Open/Close valve operation

Never operate the Chuck Open/
Close Valve while the Spindle is
running.

This will destroy the Spindle.  
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Air Pressure and Quality

Never run IBAG spindle with Pressurized Air
disconnected.

This will destroy the Spindle.

Use Clean Air

The Spindle is sensitive for the Pressurized
Air quality.

Regularly check the Air Pressure Reduction
Valve according to the Maintenance
Description.

Maintain Bit Clamping

Un-proper bit clamping may cause the bit to
slip in the chuck and damage the Table Top.

1. Keep the bit shaft clean.
2. Avoid greasy fingers.
3. Clean the bit shaft with acetone if

necessary, but use only dry cotton tips on
the chuck.

4. Maintain Pressurized Air supply of 7 bar.
5. Follow procedures strictly: Chuck Change

and Clean.

Long Term Storage

More than 4 weeks storage of a Spindle or a
HPMU requires:

1. Turn the unit upside down about 20 turns
every 4 weeks.

2. The Spindle must be stored horizontally.
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Consider having a Replacement Spindle

If HPMU is used in regular production, it
is recommended to have a Replacement
Spindle.

The service interval will depend on the type of
operation, and is difficult to predict.

Indication of worn bearings may be increasing
noise, increasing vibrations or decreasing
surface finish.

Note:  When replacing a Spindle, torque the
motor clamp to 5 Nm, 44 lbf-in using a Torque
Wrench.

This is a low torque for that screw size.

Also check by hand that the Spindle rotates
smooth without any resistance.

Empty Vacuum Cleaner in time

1. Do not leave the machine running if the
Vacuum Cleaner can be over-filled. This
might cause damage.

2. Be aware the risk of suction tube clogging.
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12.8.5 Routing Advice

Milling Bits

For thin materials, use bits with short cutting length.

For best performance and minimum wear, do not let the bit stick out more than necessary.

Never use higher RPM than recommended by the bit
supplier.

Special care should be taken when using bits with
cutting diameter larger than shank diameter.
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Bits with small cutting diameter (3-4 mm; 0.12-0.16
in) are more balanced than bits with larger cutting
diameter

Thus, they can run with higher RPM, normally 60.000.

Use large diameter bits (5-6 mm; 0.20-0,24 in) when
needed only.

Typical use is to get rid of the chips in thick materials.

Max RPM (HPMU) 60.000

Router Bit Edges are brittle.

Never let bits touch each other, or other hard surfaces.

Always store in proper container.

Acrylic Bits or Multi Purpose Bits

1. Acrylic Bits (A) are polished, extra sharp for acrylic,
wood etc.

2. Multi Purpose Bits (MP) have a higher wear
resistance, and are suitable for aluface, plastics,
MDF, plywood, wood etc.

Multi Purpose Bits can be identified by a small
tooth at the tip (left hand bit on the picture).

Feed Rates

One-flute Bits do have a good chip flow, and allow
for large feed rates. 0.1-0.2 mm/tooth (0.004-0.008 in/
tooth) can be a starting point for optimization in most
materials:

This gives a feed rate of of 4-8 m/min (2.6-5.2 ips) at
40.000 RPM, and 6-12 m/min (3.9-7.9 ips) at 60.000
RPM.

Light materials, like PVC foam can be run much faster.

The surface finish or the Power Consumption
will normally determine the final Feed Rate for an
application.

A large drop in RPM, or a high %Watt value in the
display, indicate too high Feed Rate.

92



12Kongsberg XP

Large diameter bits require more power than small
diameter bits.

Worn bits increase the Power Consumption.

Number of Passes in Thick Materials
The Number of Passes depends on Material Type, Milling Depth and Bit Diameter.

Use a Pass Depth that makes the groove free of chips, normally that is a depth equal to the
Milling Diameter.

Material Hold Down
Material Hold Down may be a limiting factor. Small parts cut loose can be a problem.

This can be done to improve the situation:

1. Use Milling Bits with smaller Milling diameter.
2. Cover unused table area to increase Vacuum Hold Down Level.
3. Use Wash-Out functions instead of creating small waste parts.

Using other tools in combination with the HPMU
It might be necessary to reduce the acceleration in order to achieve an optimal Cutting
Quality when combining a heavy tool head with high quality cutting tools.

12.8.6 Cleaner Device

Cleaning the suction house is simple using a Cleaner Device, which is available as an option.
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12.8.7 Bits and Bit Change

How to insert / replace a Router Bit

1

Ensure the Spindle is not running - the lamp is
dark.

Mind the sharp bit, and move the Suction
House up.

Lock the house in its up position.

2

Observe that the Router Bit is not rotating.

Use a cloth to hold the bit.

Move the Chuck Open/Close lever down to
open the Chuck.

Put the bit in a proper storage container.

Insert a new Router Bit.

Close the Chuck

3

Only the round part of the shaft should be
inside the Chuck.

See the Bit Length and Position – chapter for
more information. 
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4

Release the Lock to allow the Suction House
moving down to its down position.

5

Regularly, perform a Chuck cleaning, following
the dedicated procedure; Chuck Change and
Cleaning on page 96.

Note:  Never use Compressed Air for
cleaning.

If a Milling Bit is stuck

If a Milling Bit is stuck in the chuck, the probable cause is low air pressure.

To release a Milling Bit from the chuck, a pressure of 7 bar is required.

If necessary, check the Pressurized Air Regulator Valve, or the Pressurized Air source.  

If the bit is still stuck, see the Chuck change and cleaning section about how to unscrew the
chuck.
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12.8.8 Chuck Change and Cleaning

Clean the taper and the chuck regularly for proper operation and optimum life time; at least
once a week, but more often if necessary.

Follow the procedure strictly.  

Normally, the chuck has a long lifetime.

Extended vibrations or impacts may hurt the chuck, and cause bad milling results.

Trying a new chuck is the easiest way to identify if the chuck is the problem.

Running with a bad chuck will also increase the spindle wear.

Procedure

1

Place the Tool Head on the table.

Open the chuck and remove any bit.

Note:  Never apply Compressed Air for
cleaning.

2

Apply the 17 mm key to hold the Spindle
Rotor.

Note:  Do not turn the rotor when Chuck is in
open position.

This might damage the Spindle.
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3

Enter the Chuck Tool with a Dummy Bit into
the chuck.

4

Hold the rotor with the 17 mm key and
unscrew the chuck using the Chuck Tool.

If the bit is stuck, hold the rotor with the 17
mm key and unscrew with a 12 mm key.

Note: Tool Open must be pressurized.

5

Use the Taper Brush to clean the Taper.
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6

Push the Air Clean Button to help remove
contamination.

7

The Taper Brush must be absolutely free from
grease or oil.

If necessary, you must clean it with alcohol
before you use it.

This is very important, as it has direct
consequence for the clamping force.

8

Apply small quantities of grease to the threads
of the chuck, and to the outer cone and
cylindric surface of the chuck (green arrows).

Avoid the clamping area (red arrow).

Do not use oil, as it could enter the clamping
area and reduce the clamping force.

9

Torque up the chuck by hand, using the Chuck
Tool with a Dummy Bit.

Hold the rotor with the 17 mm key.
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10

Close the chuck on a Dummy Bit.

11

Chuck Maintenance Kits are available in the
Esko Store on www.esko.com.

12.8.9 Bit Slipping, Chuck Change

Even though the chuck is expected to have a long lifetime, replace it immediately if you
experience any problems as:

1. Bit slipping.
2. Bit vibrations.

When replacing the chuck, follow instructions in Chuck Change and Cleaning on page 96.

New chucks are available from Esko store.
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12.8.10 Bit Length and Position

Keep distance d small.

For best performance and minimum wear, do
not let the bit stick out more than necessary.

Use bits with short cutting lengths for thin
materials.

For proper clamping, keep distance e 20 mm,
0.8 inch, as a minimum.

To achieve material through-cut, the distance d
must be at least 18 mm/0.7 inch.

Balanced Bits

Bits with balanced surface should have a
clamping length f of min. 20 mm/0.8 inches.

Maximum balancing length g is 12 mm/0.5
inches.

12.8.11 Tool Adjustment

Complete the following adjustments:

Adjustment Description
Tool Height Measured automatically, possible to add an Offset Value.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

Notes regarding Tool Height adjustment:
When properly adjusted, the Router Bit should barely touch the top surface of the material.
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12.8.12 Table Top and Tool Height Adjustment

The following rules apply when adjusting HPMU

T = Cutting table

C = Cutting Underlay  

Map table top function is carried out on top
of the Cutting Underlay.

    

U = Milling Underlay  

The Table Top Reference function is carried
out on top of the Milling Underlay

The Tool Height is measured automatically.  

If, after a test cut, you want to modify the Milling Depth, this is possible from the Tool Height
Adjustment dialog.

The following rules apply when Milling:

Mill on Cutting Underlay (C):
To avoid damage to the Cutting Underlay, the
downward movement of the drill-bit is stopped
2 mm / 0.08 inch above the cutting underlay.

Thus, it is not possible to mill through the
material in this case.

Tool Height will follow the mapped tabletop.

Milling Underlay (U) on top of the Cutting
Underlay:

To be able to mill through the material, the
thickness of the Milling Underlay must be > 2
mm / 0.08 inch.

If the thickness of the Milling Underlay (U) is <
5 mm ( 0.2 inches ), the Tool Height will follow
the mapped table top.
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A stiff Milling Underlay (S) on top of the
Cutting Underlay:

If the thickness of the Milling Underlay (S) is
> 5 mm (0.2 inch), the underlay is supposed to
be more or less stiff.

One typical milling underlay material is MDF,
face milled on top.

In this case, when the underlay is supposed to
be stiff, the measured Table Top Reference
value is used for height control.

12.8.13 Miscellaneous

Warm Up

Machine Panel Toolbar->Warm Up

To protect the Spindle, mandatory Warm Up is implemented.  

If the Spindle has been inactive for 8 hours or more, a 3 min. Warm Up is required.

If the Spindle has been inactive for 4 weeks or more, an extended sequence is required, called
Run In.

This takes 20 minutes.

Suction House
Clean the Suction House when necessary.

Use acetone and a q-tip.

A smooth surface will ease the chip removal.
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Vacuum clean the Milling Underlay

The Vacuum Cleaner can be used for automatic cleaning of the felt mat:

Prepare program to make a file that covers the actual area.

Set “bit size” to 65 mm (2.5 inch).

Hint:

• Make a file name that reflect the size used.
• Prepare Layer Setup with low spindle speed, zero depth, and maximum feed.

• Insert the Dummy Bit into the chuck.

• Adjust the brush height until the brush barely touches the mat surface.

12.8.14 LubriCool

Introduction

LubriCool mounted on HPMU.

• A - inspection window.
• B - Suction cup with nozzles.
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LubriCool control unit

How to use

LubriCool is on when the Vacuum Cleaner is
on.

For materials where lubrication is not suitable,
use the ON/OFF switch on the LubriCool
Control Unit to switch off lubrication.

Inspection Opening

When the LubriCool unit is on, you can see
light in the control relays inside the unit.

Oil
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For LubriCool, use this oil only:

Accu-Lube LB-5000

Use Nozzle Unit or Suction Ring

Nozzle Unit Suction Ring

is delivered with one Nozzle Unit for the LubriCool function and one Suction Ring with just a
brush, and with bigger suction opening.

• Use the Nozzle Unit when the LubriCool function is beneficial only!

• For all other materials, especially MDF, use the Suction Ring!

Note:  It is crucial for proper operation that these guidelines are followed.

How to interchange the Nozzle Unit / Suction Ring

Cleaning

105



12 Kongsberg XP

Proper cleaning is crucial for correct operation.

• Release locker A and remove the nozzle
unit.

• Use vacuum cleaner to clean the HPMU
suction house.

• Use vacuum cleaner to clean the nozzle
unit.

12.9 Chiller no 1 for HPMU

12.9.1 Introduction

This is chiller 1, replaced in October 2016 by a new model named chiller2016.
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12.9.2 Chiller Heater, Operation

Notes:

1. The Chiller Heater is optional.
2. The Chiller Heater must be filled with

water before connecting mains.
3. The Chiller Heater is correctly configured

when shipped from the factory. Normally,
there is no need for modifications.

Some operating instructions are included here
if any modifications are still needed.

Press On/Off button to start the heater. The letters BCS are displayed. To
turn unit off, push and hold the button for 3 seconds.

Media temperature is displayed.

Green light on - the unit is on, and the specified temperature is reached.
Green light flashing - heating elements are operating.

Red light on – fault condition (over-heating, cable breakdown)

Program selection
Press and hold the Menu button for 3 sec.

Use arrow keys to select program

Press Menu button to confirm selection.

Temperature setting
Use arrow keys to select temperature

Press Menu button to confirm selection.
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Programs available
Program Temperature range

from (oC)
Temperature range
to (oC)

Hysteresis

0 Frost protection 5
1 10 85 7
2 10 70 7
3 10 50 7
4 10 85 4
5 10 50 4
6 10 85 5
7 10 50 5

Factory Setting
Correct factory setting is Program = 5 and temperature = 26 oC (Chiller with heater).

12.9.3 Chiller, Error Conditions

One common error signal is routed from the Chiller system to
the inverter and further into the control system.

The following error conditions are monitored:

• Temperature out of range (high and low)
• Liquid flow too low (less than 0.5 l/min). The signal is 1

minute delayed.
• Temperature sensor failure

 

If any chiller failure occurs, you have to look at the chiller display to see the real reason for the
problem:

Code Description
E0 Sensor failure: cable defective, connection failure, sensor defective.
IA Water level of water flow too low.  
HI Temperature of cooling medium too high  
LO Temperature of cooling medium too low  

During normal operation, the cooling medium temperature is displayed.  

More information is available from the Operating instructions for the chiller.
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12.10 Chiller2016 for HPMU

12.10.1 Introduction

Specifications

Dimensions
W x D x H = 480 x 580 x 430 mm / 19 x 23 x
17 in.

Weight
Empty: 40 kg / 88 lbs.
Filled with water: 49 kg / 108 lbs.

Internal heater

This chiller is equipped with an internal, automatic heater.

Chiller Unit
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12.10.2 Startup

Ensure the following pre-requisites are in place for correct startup:

• Note:  Never start the chiller without liquid.

• Signal cable (to inverter) is connected to the chiller unit.
• Chiller fluid level should be MAX. If not, fill with fresh water.
• If water temperature is too low, wait for the temperature to attain proper value ( 19oC /

66oF ).

The chiller is equipped with an internal, automatic heater.

First time startup

• Check that the supply matches the rated voltage.
• Check that the electrical connection has been made correctly.

12.10.3 Error Conditions

One common error signal is routed from the Chiller system to
the inverter and further into the control system.

The following error conditions are monitored:

• Temperature out of range (high and low)
• Water level too low
• Liquid flow too low (less than 0.5 l/min). The signal is 1

minute delayed, to be able to fill water hoses at startup..

 

During normal operation, the cooling medium temperature is displayed.  

If any chiller failure occurs:

• Alarm signal is generated.
• Chiller will stop.
• Look at the chiller display to see the real reason for the problem:

Code Description
AL Water level or water flow too low. Check for correct water level in the

Water Level Indicator on Chiller front. 
H1 Temperature of cooling medium too high, > 35oC / 95oF  
L1 Temperature of cooling medium too low, < 19oC / 66oF 
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Continue after error situation

• Find root cause for the error situation and fix it. Flow too low is normally caused by a
squeezed water hose.

• Switch chiller unit OFF and ON again.

More information is available from the Operating instructions for the chiller.

12.11 VibraCut

The VibraCut is available in two models:

VibraCut

Running with 6000 RPM and amplitude +/- 0.15 mm (0.006 inches), this tool is recommended
for light duty Corrugated Materials.

HF VibraCut (High Frequency VibraCut)

Running with 12000 RPM and amplitude +/- 0.6 mm (0.024 inches), this tool is recommended
for more demanding Corrugated Materials.

Note: Hearing Protection is recommended when working with this tool.

Common to both models:

• To reduce material tear, a foot is available.
• The same set of Knife Adapters can be used.
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Replace Knife Blade
Pull straight out to remove the Knife Foot.

Loosen the screw A and replace the Knife
Blade.

Ensure the Knife Blade has correct position
relative to the screw.

Push the Knife Blade down while the screw is
fixed.

Extreme care should be taken when inserting
the Knife Foot again.

Keep fingers away from Knife Blade as
illustrated at left.

Tool Adjustment

For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Knife Lag depends upon the Blade Adapter.
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Adjustment Description
Nominal value is 0-3 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

12.12 Rigid Material Knife (RM Knife Tool)

Replace Knife Blade

Use a 3 mm Allen key to fix / loosen the Knife
Blade.
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Ensure the Knife Blade is correctly aligned.

 No additional adjustments are necessary, as the tool height is measured automatically.

Tool Adjustment

For this tool, complete the following adjustments:

Adjustments Description
Lag Setting The Knife Lag depends upon the Blade Adapter.

Nominal value is 0-4 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

12.13 HiForce Knife

HiForce Knife is a general purpose knife tool suitable for cutting a wide range of materials.

As the name indicates; this tool is prepared for a higher tool pressure compared to the Static
Knife.
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The tool is prepared for a wide range of Knife Blades.

To reduce material tear and also to keep the material down as the Knife Blade is pulled out, a
Knife Foot is available.

Replace Knife Blade

Pull straight out to remove the Knife Foot.

Loosen the screw A and replace the Knife
Blade.

Ensure the Knife Blade has correct position
relative to the screw.

Push the Knife Blade down while the screw is
fixed.

Extreme care should be taken when inserting
the Knife Foot again.

Keep fingers away from Knife Blade as
illustrated at left.
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Tool Adjustment

For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Knife Lag depends upon the Blade Adapter.

Nominal value is 0-3 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter

Replace Knife Adapter

To remove the Knife Adapter, just pull it out
from the holder.

12.14 Psaligraphy Knife

Note:  iPC version 2.0 or higher is required to run this tool.
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Psaligraphy Knife is a tool for
cutting of fine details in paper and
folding carton.

Replace Knife Blade

For Knife Blade change, remove the foot.

The locking screw will always point towards the
cutting direction

Note: Be extremely careful when mounting the
foot.

Tool Adjustment

For this tool, complete the following adjustments:

Adjustment Description
Lag Setting The Knife Lag depends upon the Blade Adapter.

Nominal value is 0-3 mm.

Tool Height Measured automatically, possible to add an Offset Value.
Tool Rotation Adjust Tool Angle tangential to Moving Direction.
Center Offset Adjust Tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter.
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12.15 PressCut

PressCut is a special knife tool for vinyl cutting.

The Cutting Depth is controlled by the downward knife pressure.

The pressure is adjustable from Opened Job->Edit Layer dialog.

For applications where a more accurate depth control is required, a simple foot solution is
available.

The tool is prepared for a wide range of Knife Blades.

Replace Knife Blade

This figure shows how the Knife Blade is fixed
inside the PressCut Knife Tool.

The friction between the Alignment Pin A
and the Knife Blade keeps the Knife Blade in
place.
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A special hand tool is available as an aid when
replacing Knife Blades.

Use this hand tool when removing and
inserting Knife Blades into the tool.

When inserting a new Knife Blade, ensure the
blade is correctly positioned relative to the
Alignment Pin.

Configure Tools

Tool Pressure
PressCut can run with a Constant Tool Pressure or a Speed Dependent Tool Pressure.

Both parameters are specified in the Configure Tools or Opened Job->Layer structure.

Constant Tool Pressure

In the dialog, specify the Tool Pressure.

The pressure is entered as a gram - value from 40 to 700 grams.

The Knife Pressure is modified if Speed Dependent Tool Pressure is specified, see below.

During the tool down movement, the knife moves down until the material surface is detected
and the proper Knife Pressure is achieved.

The Knife Pressure needed will vary depending upon the material.

For a typical Vinyl Cutting Job, a recommended start parameter is Knife Pressure = 65-70
gram and Speed Dependent Tool Pressure = 50%.

Note:

For the PressCut to work properly, a sharp Knife Blade is critical.

Pay special attention to the tip of the Knife Blade, as it is easy to break.
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Speed Dependent Tool Pressure
In the dialog, specify Ramp and a Ramp Value.

The Ramp Value is entered as a % - value.

The upper curve illustrates the speed of the
machine when executing a line.
 

Curve A illustrates the Knife Pressure if the
Speed Dependent Pressure is set to 0; the
pressure is constant from start to stop.

TheKnife Pressure level is as specified by
the Knife Pressure parameter, see previous
chapter.
 

Curve B illustrates the Speed Dependent Tool
Pressure.

Ramp Value is set to 100.

When running at full speed, the pressure is the
double of the Knife Pressure A.
 

This function is useful as it allows a lower
pressure in both ends of a line where the
speed is low at the same time as you get a
higher pressure when running at full speed.
 

Note: The maximum Ramp Value is 200%.

Foot solution

Normally, the PressCut Knife Tool is used
without the foot mounted.  

When the foot is mounted, the Cutting Depth
d is controlled by the adjustable screw S.
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Procedure:

1. Press clamp C as indicated to lock the Knife
Shaft.

2. Turn the screw S to adjust the Cutting
Depth. When seen from the Knife Blade
side, a clockwise adjustment will increase
the Cutting Depth.

12.16 RotaCut

RotaCut is a special tool for cutting light materials, as thin fabric.

Maximum Cutting Depth is 2 mm / 0.07 inch.  

Note: Due to the characteristics of this knife tool, some restrictions apply to the use of it:

• It is not suitable for curves with small diameter.
• It is not suitable for designs containing short lines in combination with sharp angles.

RotaCut is prepared for Decagonal Knife
Blades, ø25 mm / 1 inch.
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How to replace the Knife Blade

1

Use the spanner and the hexagonal screw
driver to remove the Knife Blade fixing nut.

2

Carefully remove the old Knife Blade and
insert the new one.  

Ensure the Knife Blade is properly seated.

Mount the nut and fix it properly.

3

Observe the Guide Pin in the foot and the
groove in the Tool Shaft.  

Position the foot onto the Tool Shaft as shown
at left.  

Push the foot into position.

A self-locking mechanism ensures the foot is
kept in place.  

Note: Be careful not to hit the sharp Knife
Blade.
 

4

Verify by hand that the foot movement is
smooth.
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Tool Adjustment

RotaCut is adjusted in the same way as the other C tools regarding rotation angle and offset.

Tool Height is manually adjusted:

Tool Height for RotaCut is manually adjusted
using the tool height adjustment wizard
available from the Tool Configuration dialog.

Follow the instructions in the dialog.

Be careful, though, not to adjust the cutting
depth too deep into the Cutting Underlay
(figure at left).

U - cutting underlay

M - material

D - X/Y moving direction

Layer Setup for RotaCut

Correct setting of Lag- and Width - values are
shown.

Lag: 3.5 mm / 0.14 inch

Width: 7.0 mm / 0.28 inch 

Use the Lag and Width parameters to achieve
proper corner cutting.

12.17 Braille Tool

1. Keep the tool in upright position during this process.
2. Remove the cap and the plunger.
3. Pour spheres into the tool.
4. Insert the plunger and the cap. Shake the tool lightly.
5. Push the dispensing mechanism up.
6. One sphere should be pushed out from the tool
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Plunger

The tool is equipped with a plunger that serves
two purposes:

1. To force the spheres into the internal
funnel.

2. Indicate the number of spheres remaining
in the tool. If the groove is no longer visible
it means that there is a limited number of
spheres left in the tool.

Braille Tool milling bit

The supplied milling bit is heavily unbalanced
and should not be run faster than 20.000 RPM
to avoid excessive wear to the milling spindle!

This also means that you should not use this
bit when warming up the milling spindle as the
warm up sequence exceeds 20.000rpm.

Braille Tool setup

In order to create high quality consistent braille patterns you should perform Tool Height and
Tool Offset calibrations.

Note:  It is crucial that the Tool Height is correctly set before running this tool.

The nominal value is Tool Height = Material Thickness.

Meaning, if the material is 6 mm thick, the nominal height setting should be -6 mm (minus 6
mm).

Tool Offset adjustment

Machine Connection->Tool Configuration

1 Load the Braille Tool with black spheres.
2 Cut a piece of double sided tape measuring approximately 20x20 mm /

0.8x0.8 in. and stick it to the surface of the working area. Preferably the milling
underlay or your selected substrate. It is important that the piece of tape fits
within the hole in the measuring foot with good margins.

3 Insert the Braille Tool in the MultiCUT tool head.
4 Open up the Tool Adjustment dialog.  
5 Select Braille Tool and press Adjust Active Tool…
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6 Select Tool Offset Adjustment and press Next.
7 Jog the tool head to the position of the tape so that the laser dot is placed in

the middle of the piece of tape.
8 Press Start. The machine will measure the material thickness and dispense a

sphere onto the tape piece.
If the Laser Spot is offset from the sphere, jog the tool head until the Laser
Spot is placed exactly on top of the sphere.

10 Click Finish and close the remaining tool adjustment dialogs.

Configure Tool

Menu Bar->Advanced->Configure Tools...

Braille Tool should be defined with the following parameters enabled:

• Velocity Z (max speed)
• Z-axis Depth (0)
• Drill holes (on)

Preparing Layers for Braille Tool

Opened Job->Layers->Edit Layers

When making braille signage, you need two identical Layers with the braille pattern, one for
milling holes and one for inserting braille spheres.

These Layers may consist of circles or points.

Layer: Braille Drilling
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Velocity Z
Velocity Z is material dependent and may require experimentation.
The value shown in the illustration is suitable for (and has been tested with) 3mm Dibond.

Z-axis depth
Z-axis depth is determined by the material thickness and hole depth.
It can be calculated as: Z-axis depth = hole depth – material thickness.
According to the Raster Braille manual the hole depth should be 1,07mm (0,042”).
You may find that the holes being milled are either too shallow or too deep. If so, use this
parameter to adjust to a suitable setting.  
You will see this if the spheres sit too low or too high.
The standard specifies a sphere height of 0,6mm (0,023”).
Example using 3mm Dibond: 1,07mm – 3mm = -1,93mm

Spindle RPM
Spindle RPM is material dependent and may require experimentation. The values shown in
the illustration are suitable for 3mm Dibond.

Drill holes
Drill holes check box should be enabled.

Layer: Braille Tool

Z-axis Depth
Z-axis depth should initially be set to the material thickness.
This parameter determines the pressure the Braille Tool will use to force the sphere into the
hole.
If you are using soft materials and notice indentations in the material, you can lower the value
to get a lighter pressure.
On the other hand, if the spheres are not fully inserted into hard materials, like acrylic, you
may increase this value to increase the force used by the Braille Tool.
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Drill Holes
Drill Holes check box must be enabled for the Braille Tool to work properly.

Creating a Braille Job file

Braille grade 1 & 2
Grade 1 braille is a letter-by-letter translation of texts.
If you wish to create Grade 1 braille signage you can use any available braille font. These fonts
may be freely available on the internet.
Grade 2 braille introduces abbreviations and contractions for a large number of commonly
used words.
This is the recommended/preferred method of creating braille texts.
For Grade 2 braille you will need dedicated translation software.
Translation software recommendations can be found in the Raster Braille manual supplied
with the Braille Tool.

Operations in the desktop publishing software
To create the Braille patterns select the Braille font and type the text.
Select a font size, which gives correct distance between the dots/patterns. Details are found in
the Raster Braille manual.
As with other fonts, outlines of the text need to be created before creating the output file for
i-cut Vision.
Since the Braille patterns should be drilled with the milling spindle as well as Braille spheres
being inserted with the Braille Tool, it is recommended to duplicate the Braille Layer.
Keep other graphics than Braille in separate layers.

12.18 CorruSpeed Knife

Note:  iPC version 2.0 or higher is required to run this tool.
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CorruSpeed Knife tool  is made
especially for cutting corrugated
materials.

Maximum material thickness: 7
mm/0.28 in.

Maximum knife edge height: 6.5
mm/0.26 in; requires minimum 0.5
mm/0.02 in. crush.

During processing, the corrugated
material is partly crushed by the foot.

The result is:

• You can run at high speed.
• The risk for material tear is

significantly reduced.

Foot pressure adjustment

Material crushing depends upon two
adjustments:

A - Knife tip exposed
Adjust until the distance d is 1.0
mm/0.04 in. less than material
thickness.
One turn (CW) on A increase d with
1 mm/0.04 in.

B - Foot pressure
Adjust foot pressure.
C - scale indicating actual pressure.

For optimal performance, the foot pressure must be adapted to each material.

Run some test cuts to find the best combination of knife tip exposure and foot pressure.

Start with foot pressure = 5 and test with different knife tip exposures.

By this, you can find and save settings that are optimal for each type of material.
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Note

When adjusting the knife tip exposure, do not
adjust the knife tip too far into the foot.

The limit is when the knife tip is flush with the
front edge of the foot,

or the inner sleeve is flush with the outer
sleeve.

Insert Knife Blade

For Knife Blade change, remove the foot.

• The locking screw will always point towards the cutting direction
• Note: Be extremely careful when mounting the foot.
• Observe the alignment pins.
• After a blade change, the tool depth should be checked again.

12.18.1 Tool adjustment

For this tool, complete the following adjustments:

Parameter Description
Lag Setting The knife lag depends upon the blade shape. Normal value is 0 mm.
Tool Height The tool tip should touch the material surface.
Tool Rotation Adjust tool angle tangential to moving direction.
Center Offset Adjust tool sideways until centered.
Tool Offset Adjust offset relative to Laser Pointer.
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For more information about how to run the adjustment wizards, see Tool Configuration.

12.19 Braille Tool

Braille Tool will enable you to create signage
readable by visually impaired people.

Braille Tool is prepared for use in combination
with HPMU.

Braille Tool, how to add spheres

1. Keep the tool in upright position during this process.
2. Remove the cap and the plunger.
3. Pour spheres into the tool.
4. Insert the plunger and the cap. Shake the tool lightly.
5. Push the dispensing mechanism up.
6. One sphere should be pushed out from the tool
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Plunger

The tool is equipped with a plunger that serves two
purposes:

1. To force the spheres into the internal funnel.
2. Indicate the number of spheres remaining in

the tool. If the groove is no longer visible it
means that there is a limited number of spheres
left in the tool.

Braille Tool milling bit

The supplied milling bit is heavily unbalanced
and should not be run faster than 20.000 RPM
to avoid excessive wear to the milling spindle!

This also means that you should not use this
bit when warming up the milling spindle as the
warm up sequence exceeds 20.000rpm.

Braille Tool setup
In order to create high quality consistent braille patterns you should perform Tool Height and
Tool Offset calibrations.

Before adjusting offset you should set the tool height of the Braille Tool. This can be done
manually or automatically using X-Pad.

Note:  It is crucial that the Tool Height is correctly set before running this tool.

The nominal value is Tool Height = Material Thickness.

Meaning, if the material is 6 mm thick, the nominal height setting should be -6 mm (minus 6
mm).

Tool Offset adjustment

Machine Connection->Tool Configuration

1 Load the Braille Tool with black spheres.
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2 Cut a piece of double sided tape measuring approximately 20x20 mm /
0.8x0.8 in. and stick it to the surface of the working area. Preferably the milling
underlay or your selected substrate. It is important that the piece of tape fits
within the hole in the measuring foot with good margins.

3 Insert the Braille Tool in the HPMU tool head.
4 Open up the Tool Adjustment dialog.  
5 Select Braille Tool and press Adjust Active Tool…
6 Select Tool Offset Adjustment and press Next.
7 Jog the tool head to the position of the tape so that the laser dot is placed in

the middle of the piece of tape.
8 Press Start. The machine will measure the material thickness and dispense a

sphere onto the tape piece.
If the Laser Spot is offset from the sphere, jog the tool head until the Laser
Spot is placed exactly on top of the sphere.

10 Click Finish and close the remaining tool adjustment dialogs.

Configure Tool

Menu Bar->Advanced->Configure Tools...

Braille Tool should be defined with the following parameters enabled:

• Velocity Z (max speed)
• Z-axis Depth (0)
• Drill holes (on)

Preparing Layers for Braille Tool

Opened Job->Layers->Edit Layers

When making braille signage, you need two identical Layers with the braille pattern, one for
milling holes and one for inserting braille spheres.

These Layers may consist of circles or points.

Layer: Braille Drilling (HPMU)
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Velocity Z
Velocity Z is material dependent and may require experimentation.
The value shown in the illustration is suitable for (and has been tested with) 3mm Dibond.

Z-axis depth
Z-axis depth is determined by the material thickness and hole depth.
It can be calculated as: Z-axis depth = hole depth – material thickness.
According to the Raster Braille manual the hole depth should be 1,07mm (0,042”).
You may find that the holes being milled are either too shallow or too deep. If so, use this
parameter to adjust to a suitable setting.  
You will see this if the spheres sit too low or too high.
The standard specifies a sphere height of 0,6mm (0,023”).
Example using 3mm Dibond: 1,07mm – 3mm = -1,93mm

Spindle RPM
Spindle RPM is material dependent and may require experimentation. The values shown in
the illustration are suitable for 3mm Dibond.

Drill holes
Drill holes check box should be enabled.

Layer: Braille Tool

Z-axis Depth
Z-axis depth should initially be set to the material thickness.
This parameter determines the pressure the Braille Tool will use to force the sphere into the
hole.
If you are using soft materials and notice indentations in the material, you can lower the value
to get a lighter pressure.
On the other hand, if the spheres are not fully inserted into hard materials, like acrylic, you
may increase this value to increase the force used by the Braille Tool.
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Drill Holes
Drill Holes check box must be enabled for the Braille Tool to work properly.

Creating a Braille Job file

Braille grade 1 & 2
Grade 1 braille is a letter-by-letter translation of texts.
If you wish to create Grade 1 braille signage you can use any available braille font. These fonts
may be freely available on the internet.
Grade 2 braille introduces abbreviations and contractions for a large number of commonly
used words.
This is the recommended/preferred method of creating braille texts.
For Grade 2 braille you will need dedicated translation software.
Translation software recommendations can be found in the Raster Braille manual supplied
with the Braille Tool.

Operations in the desktop publishing software
To create the Braille patterns select the Braille font and type the text.
Select a font size, which gives correct distance between the dots/patterns. Details are found in
the Raster Braille manual.
As with other fonts, outlines of the text need to be created before creating the output file for
i-cut Vision.
Since the Braille patterns should be drilled with the HPMU spindle as well as Braille spheres
being inserted with the Braille Tool, it is recommended to duplicate the Braille Layer.
Keep other graphics than Braille in separate layers.

12.20 Drill / Pen Tool
Tool Insert Position

If included, the Tool Insert Position is permanently mounted on the P1 - tool position.

The holder is prepared for Ballpoint Pen, Drill Tool or Ink Tool.

Note:  Tools for the Tool Insert Position can not be used in combination with HDU (Heavy
Duty Unit), Foam Knife and HPMU (High Power Milling Unit).

How to insert / remove a drill / pen tool
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Inserting a tool - push down until the
Tool is locked in position.

To remove a Tool - press the Release
Button.

Pen/Drill Motor Connector:

To release, grab the housing and lift
straight up.

To insert, move connector carefully
down and turn it until it fits.

Then just push the connector down
until it is locked in position.
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12.21 Drill Tool

This Drill Tool is for use in re-board and other paper - based materials.

The Tool is prepared for drill bits 0.5 – 6 mm (0.02 - 0.24 inches).

How to replace a Drill Bit

Push the Drill Bit towards the bottom of the
chuck.

Use the wrench to fix the bit in the chuck.

No additional adjustments are necessary, as
the tool height is measured automatically.

Tool Adjustment

For this Tool, complete the following adjustments:

Adjustment Description
Tool Height Measured automatically, possible to add an Offset Value.
Tool Offset Adjust offset relative to Laser Pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter
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12.22 Ballpoint Pen

Ballpoint Pen is available for pen drawing.

Tool pressure is adjustable by a knob on top of the tool.

Tool Assembly and Pressure Adjustment

A - Inner sleeve.

The Ballpoint Pen refill is fixed inside the
sleeve using a screw.

Use Allen Key, 3 mm.

B - Sleeve holder with spring and Pressure
Adjustment Knob.

C - pen tool

Adjust Tool Pressure using the screw s.

Lock the adjustment screw using the locking
knob k.

Tool Adjustment

For this tool, complete the following adjustments:

Adjustment Description
Tool Height Measured automatically, possible to add an offset value.
Center Offset Adjust tool sideways until centered.
Tool Offset Adjust offset relative to laser pointer.

For more information about how to run the Adjustment Wizards, see the Tool Configuration
chapter
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12.23 Measuring Foot

The Measuring Foot (M) has 3 functions:

1. Measure the thickness of the material on the table
2. Map Table Top Surface.
3. Calibration of the Measuring Station. No adjustments are necessary.

12.24 Laser Pointer
The Laser Pointer (L in the illustration) is a Class II laser beam Pointing Device.

Wavelength: 650 nm, 1 mW.

The Laser Pointer is used in adjustment wizards and job execution to indicate current position
on the table.

The Laser Pointer is lit as long as it indicates the correct current position.

If there is no manual operation of the table, the Laser Pointer will be switched off after a 30
sec. time out.

Pressing any button on the Operator Panel will switch the Laser Pointer on again.
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13. Maintenance

13.1 General

Warning

The Main Power should be switched off before cleaning is carried
out.

More detailed information about C system maintenance is available in
the Maintenance Manual.

13.2 Daily Maintenance

Inspect

• Inspect the equipment in order to prevent any
irregularities.

Clean

• The Table Surface should be kept clean at all times. For
cleaning, use iso-propyl alcohol or white-spirit.

• The room should be cleaned regularly. Keep the cables
free from grease, floor vax etc.

• Use a Vacuum Cleaner to keep the inside of the
Conveyor belt clean.

13.3 Weekly Maintenance
Guide-ways and Bearings

The guide-ways and the bearings should be thoroughly cleaned and oiled very lightly with
Tellus R10 oil.  

Photo Cells
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The surface of the Transmitter and Receiver should be carefully cleaned using light soap and
clean water.

Air Pressure Reduction Valve

The automatic draining action of the Air Pressure Reduction Valve should be controlled:

1. Switch off the Air Compressor and allow the air pressure to fall.
2. Switch on the Air Compressor and check that any water in the glass bowl of the pressure

reduction valve drains out automatically during the first few seconds of operation.
3. Remove and clean the bowl if the automatic draining action does not operate or if it

appears to be an excessive amount of dust in the bowl.

Warning

If the automatic draining action fails, water can enter the Tool Assembly resulting in severe
damage.

13.4 Monthly Maintenance
Monthly Maintenance includes:

Gears

The Gears in X1, X2 and Y should be re-greased using the Grease Gun:

X1 X2 Y

Racks

The Racks in X1, X2 and Y should be re-greased:
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X1 X2 Y

Vacuum Table

Every other month, or after the table surface has been cleaned, the closed vacuum holes in the
surface should be opened in order to retain the hold-down efficiency.

Use a steel pin, 0.5 - 0.6 mm.

With the Vacuum System switched on, free the vacuum holes by pushing the obstructions
down into the table.

13.5 Maintenance, External Equipment
All external equipment, as PC, Vacuum pump and compressor should be maintained according
to the User Manual for the actual equipment.
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14. Fuse Replacement

Before starting the Fuse Replacement procedure:

• Switch Power Off using the Main Power Switch

• Remove the Main Power plug from the wall socket

Note: Some of the equipment described here is optional.

14.1 MPU fuses

MPU Location

Note: MPU location is model dependent.

All fuses are located on the rear side of the Main Power Unit (MPU).

Fuse Location

Procedure

1. Remove base cover in front of MPU
2. Remove one fuse and check with ohm-meter. If blown, replace with a new identical fuse.
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3. Repeat for each fuse.
4. Replace base cover
5. Insert main power cable into the wall socket and turn main power on.

Fuse Details
All fuses are: 1 1/4 x 1/4 in (6,3 x 32 mm)

Fuse location 115V 230V
Line fuses F1 and F2 T 15A 250V T 6,25A 250V
200V Servo power fuse F200 T 15A 250V T 15A 250V
48V Servo power fuse F48 T 8A 250V T 8A 250V
+24V fuse F4 T 6.25A 250V T 6.25A 250V

14.2 X1

X1 Amplifier Location

Fuse Location

1 – 8/24A AC amplifier X1
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2 – SCU unit

Procedure

1. Remove X1 cover.
2. Remove cover from AC amplifier unit.
3. Check fuses F2 – F5 with ohm - meter. If blown, replace with a new identical fuse.
4. Replace covers.
5. Insert main power cable into the wall socket and turn main power ON.

Fuse Details
T 10A 250V (5 X 20 mm).

14.3 X2

X2 Amplifier Location
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Fuse Location

Procedure

1. Remove X2 cover.
2. Remove cover from AC amplifier unit.
3. Check fuses F2 – F5 with ohm - meter. If blown, replace with a new identical fuse.
4. Replace covers.
5. Insert main power cable into the wall socket and turn main power ON.

Fuse Details
T 10A 250V (5 X 20 mm).

14.4 Y
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Y Amplifier Location

Fuse Location

1 – Y-motor with encoder.

2 – TCU.

3 – AC amplifier for Y.

4 – Z1 – motor.

5 – Z2 – motor

Procedure

1. Remove Y cover.
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2. Remove cover from AC amplifier unit.
3. Check fuses F2 – F5 with ohm - meter. If blown, replace with a new identical fuse.
4. Replace covers.
5. Insert main power cable into the wall socket and turn main power ON.

Fuse Details
T 10A 250V (5 X 20 mm).

14.5 P1/P2 fuses

P1/P2 Amplifier Location

Fuse Location

1 – Y-motor with encoder.

2 – TCU.

3 – AC amplifier for Y.

4 – P1 – motor.

5 – P2 – motor
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Procedure

1. Remove Y cover.
2. On the TCU – unit, check fuses Fz1 and Fz2 with ohm - meter. If blown, replace with a new

identical fuse.
3. Replace covers.
4. Insert main power cable into the wall socket and turn main power ON.

Fuse Details
T 4A 250V 1 1/4 x 1/4 in (6,3 x 32 mm).

14.6 Tool Rotation/Reciprocating Knife

Tool Board location
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Fuse location:

Fhr - Tool rotation fuse.

Fu/d - Tool up/down or tool reciprocation fuse.

Procedure:

1. Fuses are available on the Tool Board inside
the actual tool.

2. Remove the plastic cover on the tool.
3. Remove fuse Fhr or Fu/d as illustrated

above (lift straight up).
4. Check with ohm - meter. If blown, replace

with a new identical fuse.
5. Insert main power cable into the wall socket

and turn main power ON
6. For information about fuse sizes, see table

below.

Fuse Details
Tool Head Function Fuse Fuse

Size
Fuse Type

Drill Tool Drill Fhr 2 T 2A 125V NANO (42441618)
Hiforce Knife Tool Tool Rotation Fhr 2 T 2A 125V NANO (42441618)
HF VibraCut Knife
Tool

Tool Rotation Fhr 2 T 2A 125V NANO (42441618)

HF VibraCut Knife
Tool

Vibration Fu/d 4 T 4A 125V NANO (42444828)

Presscut Knife
Tool

Tool Rotation Fhr 2 T 2A 125V NANO (42441618)

Presscut Knife
Tool

Tool u/d Fu/d 0.75 T 0,75A 125V NANO (42442541)

RM Knife Tool Tool Rotation Fhr 4 T 4A 125V NANO (42444828)
RotaCut Knife RPM   2 T 2A 125V NANO (42441618)
VariCut Knife Tool Tool Rotation Fhr 2 T 2A 125V NANO (42441618)
VariCut Knife Tool Knife Depth Fu/d 0.5 T 0,5A 125V NANO (42441600)
VibraCut Knife
Tool

Tool Rotation Fhr 2 T 2A 125V NANO (42441618)

VibraCut Knife
Tool

Vibration Fu/d 2 T 2A 125V NANO (42441618)

HDU (XP) Tool Rotation Fhr 4 T 4A 125V NANO (42444828)

14.7 Chiller1 fuse
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Remove the on/off button Remove cover (4 screws)

Fuse location Pull out the fuse holder

Turn the fuse holder 90 deg. Now you have easy access to the fuse.

1 - Spare fuse

2 - Fuse in action

Fuse:

115V: T 2A 250V (5x20 mm)

230V: T 1A 250V (5x20 mm)
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14.8 Heater for Chiller Fuse

Heater Fuse Location

The Fuse is available inside the connector cover.

Fuse details
F - 4A 250V T 5x20mm Slow Blow (42448944)

14.9 Chiller2016 Fuse replacement

Fuses are located on the PCB inside the Chiller
unit.

Each fuse is protected by a cover as shown
upper right.

Lift straight up to remove.

Fuses when 115 V:

F1 - T 16A 250V (5 X 20 mm) (42468066)

F2 - T 16A 250V (5 X 20 mm) (42468066)

F3 - T 500 mA 250V (5 X 20 mm) (42468074)

Fuses when 230 V:

F1 - T 12A 250V (5 X 20 mm) (42468082)

F2 - T 12A 250V (5 X 20 mm) (42468082)

F3 - T 500 mA 250V (5 X 20 mm) (42468074)
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14.10 TakeUp Unit, Fuse replacement

The fuses are mounted on the main electrical
mounting plate behind the sheet metal cover
on the right side of the machine.

Fuse F1:

T10 A, 250V, 5x20mm (42448985)

The same fuse size is used regardless
115V/230V.

Fuse F2:

T2.5 A, 250V, 5x20mm (44347540)

The same fuse size is used regardless
115V/230V.
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15. Roll Feeder

A – Bracket Position Pin (push the center button to release the lock).

B – Roll Holder Bracket.

C – Brake Position Locker.

D – Roller Brake.

E – Brake Tension adjustment. Turn clockwise to increase tension.

To adapt to different roll sizes, three Roll
Holder Positions are prepared.

To move the roller bracket, remove pin (A) and
release locker (C).

To disengage the Roller Brake, release the
Brake Position Locker (C) and tilt the bracket.
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16. Collector Basket

The unit is placed in the unload end of the conveyor belt (front of table).

The unit is prepared for rigid pieces up till 200x200 mm / 8x8 in, or flexible materials.

Maximum load weight is 30 kg / 65 lbs.
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17. TakeUp Unit

17.1 Introduction

Scope

This manual refers to the TakeUp Unit

The manual contains useful and important information for proper functioning and
maintenance of the machine.

It also contains important instructions to prevent accidents and serious damage prior to and
during operation of the machine, and it enables the product to perform as safely and flawlessly
as possible.

• Read this manual carefully before starting the machine.
• Familiarize yourself thoroughly with the functioning of the machine
• Strictly observe the directions given.

Liability

The data published in this manual are based on the latest information available.

They are subject to future modification.

We reserve the right to change the construction and/or design of our product, without being
obliged to adapt earlier supplies accordingly.

Warranty

The warranty conditions stated in our terms of delivery, which are in your possession, are
applicable to this product.
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The warranty on your equipment become null and void if:

• Service and maintenance are not carried out strictly in accordance with the instructions,
repair work is not carried out by our personnel or has been performed without prior written
consent.

• The TakeUp Unit is modified without prior written consent; non-original parts are used.

• The equipment is used inexpertly, incorrectly, carelessly or not accordance with its nature or
intended use.

Wearing parts are not covered by the warranty

Safety

Familiarize yourself with the pictograms.

The equipment is provided with safety and protection features.

Even so, caution is necessary when performing machine operations.

Warning pictograms in the various sections point to potential dangers. You will find these
pictograms near the text referring to the operations risks.

Work safely!

We have made everly effort to inform you as correctly and completely as possible on any
dangers associated with the operation of the machine.

You must ensure and are responsible for compliance with these behavioural guidelines.

The buyer/user is obliged to familiarize operating, cleaning and maintenance personnel with
these instructions .

17.2 Machine Description

The TakeUp Unit is a machine specially developed to take-up media, with minimum pull on the
media.

Frame

The frame of the TakeUp Unit consists out of two metal frame plates which are connected to
each other by a folded plate.

The main electrical components are mounted on the left frame plate.

The left and right side of the TakeUp Unit are protected with metal cover plates which are
mounted to the frame plates. Other machine sub-assemblies are mounted in between the
both metal frame plates

Operation
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There is one switch on the left top-side of the TakeUp Unit.

This switch switches the machine on and off.

The emergency stop on the top of both sides of the TakeUp Unit can be used to stop the
machine immediately.

The dancer roller controls the turning direction of the TakeUp Unit .

When there is new media provided to the TakeUp Unit by for example a cutting table, the
dancer roller will follow the media and lowers in the machine.

When the dancer roller lowers in the TakeUp Unit, the machine will start winding the material
till the dancer roller rises to his neutral zone.

Winding shaft

The TakeUp Unit is equipped with a Autogrip shaft, which is driven on the left side of the
machine.

This autogrip shaft has a variable winding speed depending on the height of the dancer roller.

Machine Identification

The TakeUp Unit has an identification label, a typical label is shown in the picture.

The identification label is positioned on the left side of the machine, where the power cable is
entering the machine.

17.3 Safety

General

The TakeUp Unit has safety equipment to promote safe machine operation, see next chapter.

You must, however, take note of the following:

Make sure that clothing, long hair etc. are not caught by rotating rollers, which would involve
the risk of being trapped.

Emergency stop button:

The Emergency Stop buttons are positioned on top of the safety covers at the TakeUp Unit.

Press the Emergency Stop button to stop all rotating parts at once.
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Pictograms

DANGER: VOLTAGE

Only qualified personell is authorised to open these parts of the
machine to perform maintenance operations.

In this case, ensure that the power is turned off.

Do not remove or open the left metal safety covers of the machine,
you may get injured by voltage or rotating parts.

Open or remove the covers only to carry out maintenance. In this
case, ensure that the machine is powered down.

Do not place heavy objects on the power supply cord.

Do not place objects on the covers.

The machine has two emergency stop buttons which may be pressed
in dangerous situations.

Pressing one of the emergency stop buttons will immediately result in
halting of the moving and rotating parts.

Obligations of the Owner

The owner of the machine has to make sure that the only people allowed to work with and on
the machine have understood the basic rules on workplace safety and accident prevention.

The owner will make sure that the personnel is trained in the handling of the machine and
have been familiarized with the operating and safety instructions contained within this manual.

The safety awareness of personnel shall be reviewed at regular intervals.

Obligations of the Personnel

All individuals working with and on the machine commit to be familiar with the basic
regulations on industrial safety and accident prevention and the section on safety contained
within this manual.

Dangers caused by Operation of the Machine

The TakeUp Unit is built according to accepted engineering standards and safety regulations.

Despite that, operating the machine could result in danger for life and limb of the operator or
cause damage to the equipment or other property.

The machine shall be used only:

• For the intended use.
• In absolutely perfect condition.
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Malfunctions or damage that may affect the safety must be serviced immediately.

Intended Use

The TakeUp Unit is only intended to be used for winding up media.

Any different or additional use of the machine is considered improper and Esko is not
responsible for any resulting damage to machine or individuals.

Intended use does include:

• Following all instructions in this manual.
• Carrying out inspection and maintenance operations.

Safety Features

• Before start-up of the machine, make sure that all safety features are properly installed and
operational.

• Safety covers may only be removed and replaced when the machine is at a complete stop
and powered down.

Informal Safety Measures

• The user manual must be kept with the machine.
• In addition to the operating instruction, the local accident prevention regulations and

environmental regulations should be available.
• All safety instructions and warning pictograms must remain in legible condition.

Security Measures for Normal Operation

• Only operate the machine if all safety features are fully functional.
• Before start-up of the machine, ensure that no other individuals are to be at risk.
• Check the machine for obvious damage and the safety features being functional at least

once every shift.
• Only operate the machine if all gauges and warning lights are fully functional.

Dangers Caused by Electricity

Maintenance on the electrical system should only be carried out by qualified mechanics

17.4 Features and components

Components overview
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A - Emergency switch

B - Autogrip shaft

C - Dancer roller

D - Frame

E - Control panel

D - Waste handling kit

17.5 General operation

Control positions

The TakeUp Unit is normally operated from the right side of the machine.

Controls

At the left side of the frame are the operating switches.

These switches allow the operator to control the power (on or off), the turning direction, the
winding speed and the possibility to jog the machine.

The different controls are shown in picture:
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A - Jog forward/backward
The jog button turns the autogrip shaft slowly
forwards or backwards.
To Jog, the winding direction button has to be
set in position: 0.

B - Winding direction
The winding direction button controls the
winding direction of the TakeUp Unit.

C - Winding speed
The windig speed potentiometer controls the
winding speed.

D - Spare

E - Power button
The power button switches the machine on
or off.

F - Control lamp
The control lamps indicates if the machine is
turned on or off.

17.6 Applying Winding Material

Applying winding material to the Autogrip shaft
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Add a 3 in. coil on the Autogrip shaft.

Bring the material with the Kongsberg table
to the TakeUp Unit  till the material is fed far
enough underneath the waste handling kit to
reach the Autogrip shaft.

Take the winding material underneath the
dancer roller and paste it with tape in a
straight line onto the coil.

See picture for the typical loop of the winding
media.

Avoid angular tension in the media; the media
will start telescoping during the winding.

Note:  TakeUp Unit should be started only
when material is in place.

Infeed loop

Aligning the media on the Autogrip shaft

17.7 Start the TakeUp Unit

The TakeUp Unit is activated for processing when:

• The power button is switched on.
• The Emergency Stop button is pulled up (in de-activated position).
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The TakeUp Unit is activated.

The machine starts processing.

It stops when the dancer roller is in neutral position, the power button is
switched off or when the emergency stop is activated.

Attention:

The TakeUp Unit does not stop automaticly when the waste roll is full.

This has to be done manually by switching off the power button or by
activating the emergency stop button.

17.8 Using the Autogrip Shaft

Put the core/media roll central on the autogrip
shaft, which uses rubber blocking cords to grip
with.

Rotate the core/media roll to engage it with
the autogrip-shaft.

Note:  If a core/media roll of the same size is
often used; install a roll clamp at one side of
the shaft, to enable easy replacement.

Autogrip shaft installation

The shaft is hung in a special T-slot on one side
of the machine and a suspension point on the
other side.

The suspension points on both sides of the
TakeUp Unit are provided with a locking ring
to prevent the Autogrip shaft from falling out.

The locking ring has to be turned manually to
locked or unlocked position.

T-slot of TakeUp Unit
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Attention:

During operation, the locking rings need to be in locked position, to
ensure safe operation and avoid risks for the operator.

Locking ring in unlocked position Locking ring in locked position

Exchange media rollers

The media needs to be cut when the media roll has reached it’s maximum diameter or when
the roll has to be exchanged.

Before cutting the media, the TakeUp Unit has to be always switched off.

The tip has to be stuck to the roll to prevent unwinding during transportation.

The TakeUp Unit is provided with a jog button to get an easy exchange of the rollers.

This makes is possible to rotate the roller contrary by hand to get the T-slot in position to
exchange the media roll.

Attention:

When removing the Autogrip shaft.

Always lift the side of the Autogrip shaft near the control panel of the
TakeUp Unit first, to avoid damage to the T-slot.

Dancer roller
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The dancer roller (D) in the TakeUp Unit controls the winding of the media.

When the dancer roller lowers the winding unit will start winding, till the dancer roller rises to
the start position.

Resetting TakeUp Unit

The dancer roller will move to its lowest position when a roll of material is completed.

The TakeUp Unit will shut-off automatically, when the dancer is longer then 4 seconds in the
bottom position.

The full roller can now be replaced by a new, empty core.

The TakeUp Unit can be restarted by switching the winding direction to “0”, and then back to a
winding direction.

The TakeUp Unit will now start winding, till the dancer roller rises to the neutral position.
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18. Vacuum Cleaner

18.1 Vacuum Cleaner, Zefiro

18.1.1 How to use

Filter Shaking

Filter Shaking is important in order
to maintain a good Vacuum Cleaner
performance.

Filter Shaking is best operated every time
before use and after prolonged operation.
 

Note: This operation must be performed only
when the Vacuum Cleaner is switched off and
the motor has stopped.

Remove Material Container
1
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2

3

Note: You can use the container with or without Plastic Bag.

Use Plastic Bag in Material Container

Parts needed: Steel ring and plastic bag Fix the Plastic Bag to the ring in this way

Ring and Plastic Bag ready for the container Fold/fix the Plastic Bag around the container
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Container with Plastic Bag ready for operation

Detailed information about how to operate the Vacuum Cleaner is available in the Zefiro 75
Operators and maintenance manual.

18.2 Vacuum Cleaner, High-capacity, TB ESKO

18.2.1 How to use

Introduction

1 – Filter Chamber

2 – Filter Shaking Lever

3 – Removable Material Container
Note:

Carefully observe the Vacuum Cleaner filling
level.
If the Vacuum Cleaner container is filled up
completely, the dust removal function will stop
with a high risk for Spindle Motor damage.
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Filter Shaking

Filter Shaking is important in order
to maintain a good Vacuum Cleaner
performance.

Filter Shaking is best operated every time
before use and after prolonged operation.
 

Note: This operation must be performed only
when the Vacuum Cleaner is switched off and
the motor has stopped.

Remove Material Container

Note: You can use the container with or without Plastic Bag.

Use Plastic Bag in Material Container

169



18 Kongsberg XP

Shake the filter well before emptying the
container.

Fix the Plastic Bag to the steel bar.

Plastic Bag with bar ready for container. Fold/fix the Plastic Bag around the container.

Container with Plastic Bag ready for
operation.

Detailed information about how to operate the Vacuum Cleaner is available in the Operators
and maintenance manual.

18.3 Compact Vacuum Cleaner

18.3.1 How to use
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1. Suction tube inlet
2. Container fixture
3. Filter unit locking mechanism
4. Motor
5. Filter unit

How to empty container

1. Ensure vacuum cleaner motor is off.
2. Remove the suction tube (1).
3. Release the container (3).
4. Remove the filter unit (5).

You should have a bucket nearby for the unit.
5. Lift and turn the container to release it from the fixture.
6. Empty the container.
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19. Install Software

For information about software installation, see the Installation Manual for the actual
machine.

Available on the Documentation DVD.
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20. Frequently Asked Questions

20.1 Machine

My machine does not react when switching on
Please check electrical connection, do you have 230V? Is there enough compressed air, 7bar?
Check all main fuses in the MPU, see Fuse Replacement  
Check all connections at the MCU behind the control panel
Check all connections at the start up button and the emergency buttons:

Safety system won’t reset
Make sure all sensors are aligned correctly, check the black dots on the side of the traverse
Are all transmitters pointing correctly to their receiver? Check if the red light is shining on the
receiver. If necessary, adjust by bending the transmitter/receiver holder

During start up: X1/X2/Y servo error
This is probably caused by a defect in an amplifier board. Please contact Esko for technical
support  

During start up: X1/X2/Y fuse error
Check the fuse of the motor
If problem persists, it is likely to be the amplifier board malfunctioning. Please contact Esko
for technical support

“Missing compressed air”
Check if you still have 7 bar at the MPU
Are the hoses not bending? Can the compressed air flow easily?
Do you hear air escaping? Check for leaks
Is the connection at the head leaking air or broken?

20.2 Tools
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After cutting, the design is difficult to remove from waste
Check tool height

After cutting, the corners are still fixed to the waste
Check tool lag

Bad quality in cutting, paper/cardboard tears
Check rotation of the tool

Offset in cut/crease lines
Check tool center offset

Offset between cut lines and crease lines
Check tool offset

Machine is milling in the carpet and table top
The milling bit is lowering inside the Chuck. Please fix the Chuck with the appropriate tool.

Milling: “Inverter not started yet”
After touching the safety unit, you need to wait for 10 seconds after resetting safety for the
milling inverter to activate
If problem persists, check the connection at the tool head of the milling spindle. Is the big
green cable still well connected?
Check all connections of the milling spindle: at tool head, inside cover X1 and at the inverter
Check serial connection between inverter and PC: connection OK? COM port changed lately?
If problem still persists, contact Esko

2 or 3 tools are working at the same time
Check your compressed air, make sure you have 7 bar
Check compressed air connection at the head. Is it well connected or is it leaking air?

Machine is milling in the milling underlay

Check vacuum zones. Are all necessary zones open? You can close non-covered areas to
strengthen the vacuum.
Check the force of the vacuum cleaner. It happens the vacuum cleaner is heightening the
milling carpets. Try to adjust the force by using the regulator on the spindle / vacuum cleaner.

20.3 iPC

iPC doesn’t want to make connection with the machine
Make sure you first switch on the machine and then iPC, not the other way around
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If there was a software update recently, check if the firmware on the machine and iPC are of
the same version
Check the serial connection between PC and MCU
Check the connection at the emergency button
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